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Welcome From The Chief Editor
Talk about deja vu! Last month, as I was writing my
welcome column, the Kansas City area was bracing
for the second of two heavy snow storms to hit the
city. Between those two storms, we received in
excess of 20 inches (50.8 cm) of snow.
As late winter and early spring snow storms do, the
heavy snow fell, then it warmed up and it melted. All
of the original snow from the first two snow storms is
(was?) completely gone. Now, sitting here writing
this month’s welcome column, we got hit with yet
another spring snow storm. As I’m writing this, we’ve
received another 8+ inches (20.3 cm) of the cold,
white precipitation overnight – and it’s still coming
down.
The precipitation – in whatever form – is welcome
relief. In 2012, as the folks in London were
lamenting the excessive rain during the 2012
Summer Olympics, the U.S. suffered through one of
its worst droughts since the dust bowl days of the
Great Depression. Last July, over 55 percent of the
U.S. had been experiencing conditions of severe or
extreme drought. In some areas, like western
Kansas, it has been described as a drought feeding
upon itself. With little to no moisture to evaporate
from the ground and plants, the atmosphere remains
dry and cloud formation suffers, nixing chances for
any significant precipitation.
Even now, the drought has maintained its grip on the
country. Here is a graphic from the University of
NebraskaLincoln’s National Drought Mitigation
Center, with cosponsorship from NOAA and the
U.S. Department of Agriculture, that illustrates the
situation quite well.
I could bore you to tears with graphic after graphic
about the situation around the area where I live – but
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I won’t. The information is quite easy enough to find
on your own, if you are interested in this topic.
So, why all the talk about the weather and the
protracted drought we’ve experienced around my
area of this world? Earth Day 2013 is on April 22,
and this year’s theme is “the face of climate

change.” I created this month’s magazine cover to
highlight Earth Day 2013, and we’ve also ran a
press release from the Earth Day folks in the pages
of this month’s magazine.
It doesn’t matter on which side of the climate change
debate you reside. The climate affects each and
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every one of us on a daily basis. Around my part of
the world, the protracted drought has had a profound
effect. Not only has it affected agriculture (a huge
concern around my part of the world), but it has
affected how people care for their lawns and
gardens (many have given up until relief from the
drought is seen), it has driven food prices higher at a
time when most people’s financial situation is
weakening, it has caused groundwater reserves to
be reduced to historically low levels, and these
things represent just barely the tip of the problem.
These effects ripple outward to affect all areas of
society on a global scale. Even if you aren’t directly
affected by the drought that me, Meemaw,
BubbaBlues, grnich and many other PCLinuxOS
community members are enduring, you are affected
by higher food prices, since a lot of food grown
around this area is exported to other areas of the
world. The farther you are from the impact that
causes the ripple, the less the ripple’s effect – but
you are affected, nonetheless.
Now … to completely change the topic. Take a look
at the next image.

Yep! Another future PCLinuxOS user is on his way!
After trying – and failing – to “get pregnant” for much
of seven years, my wife Laura, is carrying our first
child. We are excited beyond description. Our new
little, future PCLinuxOS user is due to arrive August
29. The picture is from the sonogram done at 11
weeks, 1 day gestation.
By the time this issue of the magazine is released,
Laura will be somewhere between weeks 18 and 19
of the pregnancy. Yes, we kept it quiet for a while,
given the huge obstacles we had to overcome to get
here. We wanted to be sure everything was going
well before we announced our news. To top it off, we
received the best Christmas present of all last
Christmas. That is when (Christmas morning) we
first confirmed the pregnancy with a home
pregnancy test.
We just refer to him as “Little Fella,” although we
don’t yet know the gender. In “babyland,” all babies
are referred to as “hims” or “hes” until and unless
proven otherwise. We, unlike many expectant
parents, do not want to find out the gender of the
baby until it is born. We figure it was good enough
for our grandparents and parents, so it’ll be good
enough for us. We’re just happy to be having a baby,
after all of the trouble we’ve had “getting there.”
When people ask what do we want, our reply is
“healthy.”
So until next month, I wish each of you peace,
tranquility, serenity and prosperity.

Disclaimer

1.

All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2.

The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3.

The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4.

No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5.

Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.
Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.
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Earth Day 2013: The Face Of Climate Change
EarthDay.org News Release

Photos can also be uploaded on the Earth Day 2013
website.

WASHINGTON – The global theme for Earth Day
2013 is “The Face of Climate Change,” Earth Day
Network announced. Earth Day Network, the group
founded by the organizers of the first Earth Day to
coordinate the annual day of action that builds and
invigorates the environmental movement, said that
this theme was chosen because of the need to
highlight the mounting impact of climate change on
individuals around the world.

“The Face of Climate Change will not only
personalize and make real the massive challenge
that climate change presents, it will unite the myriad
Earth Day events around the world into one call to
action at a critical time,” said Franklin Russell,
director of Earth Day at Earth Day Network.

“Many people think climate change is a remote
problem, but the fact is that it’s already impacting
real people, animals, and beloved places all over the
world, and these Faces of Climate Change are
multiplying every day,“ said Kathleen Rogers,
president of Earth Day Network. “Fortunately, other
Faces of Climate Change are also multiplying every
day: those stepping up to do something about it. For
Earth Day 2013, we’ll bring our generation’s biggest
environmental challenge down to size – the size of
an individual faced with the consequences.”
Between now and Earth Day, Earth Day Network will
collect and display images of people, animals, and
places directly affected or threatened by climate
change and tell the world their stories. The
organization will mobilize its extensive global
network of Earth Day event organizers and other
partners to help collect the images. But they’re also
asking ordinary people to become “climate reporters”
and send their pictures and stories that show The
Face of Climate Change.
On and around Earth Day – April 22 – an interactive
digital display of all the images will be shown at
thousands of events around the world, including next
to federal government buildings in countries that
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Alaskan polar bear on sea ice (NOAA).

Burned up corn crop, south of Ottawa, Kansas, due to the
protracted drought … August 2012 (Paul Arnote)
produce the most carbon pollution. The display will
also be made available online to anyone who wants
to view or show it.
The campaign is focusing heavily on social media.
Organizers are asking people to tweet using the
hashtag #FaceOfClimate, and “climate reporters”
can also post photos to Twitter and Instagram using
that hashtag for inclusion in the digital display.

2012 was marked by many climate change
milestones. Arctic seaice cover reached a record
low in September, a new highwater mark in a long
term decline. The United States experienced its
hottest year ever; this, after the World
Meteorological Organization announced that the first
decade of this century was the hottest on record for
the entire planet. Public perception of extreme
weather events as “the new normal” grew as
unusual superstorms rocked the Caribbean, the
Philippines and the northeastern United States;
droughts plagued northern Brazil, Russia, China,
and twothirds of United States; exceptional floods
inundated Nigeria, Pakistan, and parts of China; and
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more. Meanwhile, international climate change talks
stagnated. But glimmers of hope for a political
solution began appearing in recent months, perhaps
most notably in U.S. President Barack Obama’s
highprofile promises to tackle climate change during
his second term.
This is why organizers say that 2013 is ripe for a
major push to confront climate change.
Each year, more than one billion people participate
in Earth Dayrelated activities, making it the largest
civic observance in the world. On and around April
22, communities across approximately 192 countries
voice their concerns for the planet and take action to
protect it.

LinPC.us

Screenshot
Screenshot Showcase
Showcase

“We’ll harness that power to show the world The
Face of Climate Change,” said Russell. “And we’ll
call on our leaders to act boldly together, as we
have, on this critical issue.”
To learn more about Earth Day 2013 and The Face
of Climate Change, go to www.earthday.org/2013.
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All your
PCLinuxOS
connections in one
convenient location!

Posted by wierdwolf, March 21, 2013, running LXDE.
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Windows Migration:
Desktop Environments & Window Managers

by agmg (Antonis Komis)
Introduction

Coming from Windows to Linux and looking for a
distribution to begin your journey with, one of the
first things you will probably notice is the difference
between them. Different names, applications,
software management, desktop environments...
wait, what? What is a Desktop Environment and how
can Linux provide so many choices?
Windows and MacOS come with a pretty standard
graphical user interface (GUI) that has very limited
customization options. The term GUI describes the
user interface that allows a user to interact with the
computer using images rather than text commands.
It typically consists of windows, icons, cursors,
panels, toolbars, wallpapers and desktop widgets.
While Windows and MacOS are designed and built
around a specific GUI, Linux’s GUI is completely
separate from the operating system itself.
The Linux desktop basically consists of four
elements:
X Window system (X11): is a computer software
system and network protocol that provides a basis
for graphical user interfaces (GUIs) and rich input
device capability for networked computers. This is
the foundation that allows for graphic elements to be
drawn on the display. The X Window system builds
the primitive framework that allows moving of
windows, interactions with keyboard and mouse,
and draws windows. This is required for any
graphical desktop.
X.org Server: X.org is the public, opensource
implementation of the X window system. Since X.org
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is the most popular choice among Linux users, its
ubiquity has led to making it an everpresent
requisite for GUI applications, resulting in massive
adoption from most distributions.
Window Manager (WM): is system software that
controls the placement and appearance of windows
within a windowing system in a graphical user
interface. It requires the X window system but not a
desktop environment.

or as a package download) and some of them are
not.
Desktop Environments
KDE

Desktop Environment (DE): includes a Window
Manager but goes beyond that concept. A desktop
environment is a far more fully integrated system
which includes a suite of applications and utilities
that are tightly integrated and will provide a more
complete
graphical
experience. A
desktop
environment will also include some form of panel
that includes a system tray where small widgets can
be placed for quick action or information.
In general, Linux distributions provide different
editions based on the desktop environment they
use. This is the case also with PCLinuxOS. But,
even though you may be using a specific desktop
environment (which includes a specific window
manager and a default set of integrated
applications), there’s nothing stopping you from
installing more. You can choose a different desktop
environment each time you login. The possibilities
and combinations are endless! Don’t be afraid to
experiment and choose the right one for you. After
all, this is one of the main advantages of Linux:
freedom of choice!
This article will try to cover most desktop
environments and window managers that are
available for Linux today. Some of them are
available in PCLinuxOS (either as a different edition

The default PCLinuxOS KDE Plasma Workspace.

KDE is an international free software community
developing a wide variety of crossplatform
applications for communication, work, education and
entertainment.
KDE is mostly known among Linux and Unix users
for its Plasma Desktop, an innovative desktop
interface which aims to be userfriendly and highly
customizable at the same time. Plasma Desktop
also includes various workspace applications to aid
with system configuration, running programs, or
interacting with hardware devices. While the fully
integrated KDE Workspaces are only available on
Linux and Unix, some of these features are available
on other platforms. Plasma Desktop currently offers
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two versions, known as Workspaces: the Desktop
Workspace, which is designed for desktop PCs or
larger laptops and the Netbook Workspace, which is
aimed at netbooks but can also be used in Tablet
PCs.

You can find more info on KDE from the official
website: http://www.kde.org/

a modern desktop environment on relatively modest
hardware.

KDE Plasma Desktop is used in the main edition of
PCLinuxOS as well as in the Full Monty edition, but
Full Monty has a special, activityfocused, desktop
layout and a lot of customizations and preinstalled
applications. KDE can also be used alongside any
other desktop environment by installing the package
taskkde4 in Synaptic Package Manager.

Xfce provides a handful of utilities for setting and
customizing the desktop environment, as well as
some key applications that add to the desktop
environment’s functionality, such as Midori, a
lightweight web browser, Thunar file manager,
Ristretto image viewer and Orage, a simple calendar
application with reminders.

KDE uses KWin as its default window manager.

You can find more info on Xfce from the official
website: http://www.xfce.org/

Xfce

Xfce is offered as a communityreleased edition of
PCLinuxOS but can also be used in other editions
by installing the package taskxfce4 in Synaptic
Package Manager.
Xfce uses Xfwm as its default window manager.

The Netbook Workspace of KDE.

In addition to the workspace, KDE produces a
number of key applications such as the Konqueror
web browser, Dolphin file manager and Kontact, the
comprehensive personal information management
suite. Other well known applications provided by
KDE are Calligra (full office suite), K3B (disk burning
software), Amarok (music player), Dragon Player
(video player), digiKam (image editor and organizer),
Gwenview (image viewer) and Okular (document
viewer). However, its list of applications includes
many others, including those for education,
multimedia, office productivity, networking, games
and much more. Most applications are available on
all platforms supported by the KDE Development.
KDE also brings to the forefront many innovations
for application developers. An entire infrastructure
has been designed and implemented to help
programmers create robust and comprehensive
applications in the most efficient manner, eliminating
the complexity and tediousness of creating highly
functional applications.
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LXDE

The default PCLinuxOS Xfce Desktop.

Xfce is a lightweight desktop environment for UNIX
like operating systems. It aims to be fast and low on
system resources, while still being visually appealing
and user friendly.

It consists of separately packaged components that
together provide the full functionality of the desktop
environment, but which can be selected in subsets
to create the user's preferred personal working
environment. Xfce is mainly used for its ability to run

The default PCLinuxOS LXDE Desktop.

The "Lightweight X11 Desktop Environment" is an
extremely fastperforming and energysaving
desktop environment. Maintained by an international
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community of developers, it comes with a beautiful
interface,
multilanguage
support,
standard
keyboard short cuts and additional features like
tabbed file browsing. LXDE uses less CPU and less
RAM than other environments. It is especially
designed for cloud computers with low hardware
specifications, such as netbooks, mobile devices
(e.g. MIDs) or older computers.

The release of GNOME 3 created great controversy
in the Linux community, mostly due to its move away
from the traditional desktop concept. This
controversy and the vast popularity of the older
GNOME 2 (which was used for almost a decade)
has led to the creation of two forks: MATE and
Cinnamon. Additionally, in November 2012 it was
announced that a classic mode would be
implemented to GNOME 3 via a set of supported
gnomeshell extensions.

Like the previous desktop environments, LXDE also
integrates a bundle of applications and utilities that
provide a complete user experience.

You can find more info about GNOME from the
official website: http://www.gnome.org/

You can find more info on LXDE from the official
website: http://lxde.org/
LXDE is also offered as a communityreleased
edition of PCLinuxOS but can also be used in other
editions by installing the package tasklxde in
Synaptic Package Manager.

PCLinuxOS with GNOME 2.32

GNOME 2 uses Metacity as its default window
manager while GNOME 3 uses Mutter.

LXDE uses Openbox as its default window manager.

MATE

GNOME
GNOME project is an international community
dedicated in making great software that anyone can
use. It provides the GNOME desktop environment,
consisting of the graphical user interface and several
core applications (file manager, web browser, music
and video players etc) and the GNOME
development platform, an extensive framework for
building applications that integrate into the rest of
the desktop and mobile user interface. It was
originally started at 1999 as an opensource
alternative to KDE, which was using the (proprietary
at that time) Qt toolkit. GNOME project is part of the
GNU project (http://www.gnu.org/).
The first version of GNOME (desktop environment)
was released on March 1999 but it wasn’t until 2002
and the release of version 2.0 that GNOME became
widely known and used in various Linux
distributions. GNOME 2 has been one of the most
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You can use GNOME 2 in PCLinuxOS by installing
the package taskgnome from Synaptic Package
Manager. GNOME 3 is not currently available in
PCLinuxOS.

MATE is a desktop environment forked from the
nowunmaintained code base of GNOME 2. The
name derives from yerba mate, a species of holly
native to subtropical South America used to prepare

Gnome 3

popular and favourite desktop environments among
Linux users and is always considered KDE’s
opposing force, (leading to great flame wars as to
which one is the best). In 2011, GNOME project
announced the release of version 3.0 (also known
as GNOME Shell) and GNOME 2 stopped being
maintained.

MATE on Linux Mint 14.1
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a beverage called mate. The renaming is necessary
to avoid conflicts with GNOME 3 components. The
project was started by an Arch Linux user and is
supported by the Linux Mint developers.
Several GNOME applications have also been forked
under new names, like Caja (a file manager coming
from Nautilus), Pluma (a text editor coming from
Gedit), Atril (a document viewer like Evince) and
many more. These applications are fully integrated
to the desktop environment and can cover many of
the user’s needs.

interface for use in future releases of Linux Mint.
Cinnamon is the team’s second attempt to improve
GNOME Shell’s interface after Mint GNOME Shell
Extensions (MGSE), a desktop layer that "sits on
top" of the GNOME 3 desktop environment and
delivers an interface that is more familiar to users of
GNOME 2 as well as to users of previous Linux Mint
distribution releases.
You can find more info about Cinnamon from the
official website: http://cinnamon.linuxmint.com/

application switcher called the launcher. Unlike
GNOME, KDE, Xfce or LXDE, Unity is not a
collection of applications but is designed to use
existing programs.
You can find more info about Unity from the official
website: http://unity.ubuntu.com/
Unity is only available with the Ubuntu operating
system.

Cinnamon is not currently available in PCLinuxOS.

EDE (Equinox Desktop Environment)

MATE is not currently available in PCLinuxOS.

Cinnamon uses Muffin, a fork of the GNOME 3
window manager Mutter, as its default window
manager from Cinnamon 1.2 onwards.

MATE uses Marco, a fork of Metacity, as its default
window manager.

Unity

EDE or Equinox Desktop Environment is a small
desktop environment built to be responsive, light in
resource usage and to have familiar look and feel. It
runs on Linux, *BSD, Solaris, Minix, Zaurus and
even on XBox.

You can find more info about MATE from the official
website: http://matedesktop.org/

Cinnamon
Cinnamon is a fork of GNOME 3 (GNOME shell),
initially developed by (and for) Linux Mint. It attempts
to provide a more traditional user environment like
GNOME 2 using the technology of GNOME 3. It is
Linux Mint’s developers team vision of the GNOME

Unity is not a complete desktop environment but a
user interface for the GNOME desktop environment,
developed by Canonical Ltd for its Ubuntu operating
system. Unity debuted in the netbook edition of
Ubuntu 10.10. It is designed to make more efficient
use of space given the limited screen size of
netbooks, including, for example, a vertical

EDE on PCLinuxOS

You can find more info about EDE in its official
website: http://equinoxproject.org/

Cinnamon on Linux Mint 14.1
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The Unity user interface

EDE uses a modified version of FLTK (Fast Light
Toolkit), a crossplatform C++ GUI toolkit that
provides modern GUI functionality without the bloat
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and supports 3D graphics via OpenGL® and its
builtin GLUT emulation.
You can use EDE in PCLinuxOS by installing the
package ede in Synaptic Package Manager.
Razorqt
Razorqt is an advanced, easytouse, and fast
desktop environment based on Qt technologies. It
has been tailored for users who value simplicity,
speed, and an intuitive interface. Unlike most
desktop environments, Razorqt also works fine with
weak machines.
Razorqt is a relatively new project but already
contains the key components of a desktop
environment: panel, desktop, application launcher,
settings center, sessions.

Razorqt doesn’t have its own window manager but
works with any modern window manager such as
Openbox, fvwm2 or Kwin.

Trinity uses its own window manager, called the TDE
Window Manager.
Window Managers

Trinity
Trinity Desktop Environment is a computer desktop
environment for Unixlike operating systems with a
primary goal of retaining the overall KDE 3.5
computing style, as well as polishing off any rough
edges that were present as of KDE 3.5.10.
KDE 3.5 was the last version of the KDE 3.x series
before 4.x was released. Timothy Pearson, Kubuntu
release manager for KDE 3.5, has released Trinity to
pick up where the KDE 3.5 left. This fork keeps the
KDE 3.5 branch alive and releases continuing bugs
fixes, additional features, and compatibility with
recent hardware. Trinity is packaged for Debian,
Ubuntu, Red Hat and various other distributions.

Window managers for X Window system, fall under
the following categories:
Compositing window managers let all windows be
created and drawn separately and then put together
and displayed in various 2D and 3D environments.
The most advanced compositing window managers
allow for a great deal of variety in interface look and
feel, and for the presence of advanced 2D and 3D
visual effects.
Stacking window managers draw all windows in a
specific order, allowing them to overlap, using a
technique called painter’s algorithm. Stacking
window managers allow windows to overlap by
drawing them one at a time.
Tiling window managers "tile" the windows so that
none are overlapping. They usually make very
extensive use of keybindings and have less (or no)
reliance on the mouse. Tiling window managers may
be manual, offer predefined layouts, or both. Most
tiling window managers allow you to “stack” windows
(dynamic tiling window managers).
Compositing Window Managers
KWin

Razorqt 0.5.0 default theme.

You can find more info about Razorqt from the
official website: http://razorqt.org/
Razorqt is available in PCLinuxOS by installing the
package razorqt in Synaptic Package Manager.
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Trinity Desktop

You can find more info about Trinity from the official
website: http://www.trinitydesktop.org/
Trinity is not currently available in PCLinuxOS.

KWin is an integral part of the KDE Software
Compilation (KDE SC) but can also be used on its
own on other desktop environments.
KWin has an extensive support for themes, window
decorations and 2D & 3D effects. Supports
compositing through various compositing backends
that currently include XRender, OpenGL 1.x,
OpenGL 2.x, and OpenGL ES 2.0. It is designed to
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be modest on hardware resources and completely
configurable and customizable.

Compiz
Compiz is a compositing window manager that uses
3D graphics acceleration via OpenGL. It provides
various new graphical effects and features on any
desktop environment, including GNOME and KDE.
Compiz has a flexible plugin system and it is
designed to run well on most graphics hardware
(bottom, left).
More info about Compiz from the official website:
http://www.compiz.org/

Desktop Cube, one of KWin’s most impressive effects.

More info about KWin can be found at KDE
UserBase Wiki: http://userbase.kde.org/KWin

KWin is the default window manager used in the
KDE and FullMonty Edition of PCLinuxOS. It can
also be used on other desktop environments by
installing the package kwin through Synaptic
Package Manager.

Compiz can be easily installed through Synaptic
Package Manager using the compiz package. Your
graphics adapter must support OpenGL to use it.
Xfwm
Xfwm is part of the Xfce Desktop Environment.
Xfwm supports themes for window borders, buttons
and title bars and has its own integrated compositing
manager. Xfwm keeps pace with the general Xfce
philosophy of being lightweight and visually
appealing at the same time.

More info about Xfwm at Xfce4
documentation website:
http://docs.xfce.org/xfce/xfwm4/start

official

As with previous window managers, Xfwm can be
used on most desktop environments by installing the
package xfwm4 through Synaptic Package
Manager. The package xfce4settings (Settings
Manager) should also be installed to provide GUI
management for Xfwm.
Mutter
Mutter is the default window manager used in
GNOME 3 which uses the Clutter graphics library
and supports numerous visual effects. It is a remake
of the old Metacity used in GNOME 2. Mutter can
function as standalone window manager application
for GNOMElike desktops and is extensible with
plugins. Developers of Linux Mint, have forked
Mutter and created Muffin, to use for their Cinnamon
operating system.
Latest versions of Mutter offer compositing
capabilities and visual effects through Clutter’s
OpenGL support. Those versions are built using
GTK+ 3.x libraries and are not currently available in
PCLinuxOS. An older version of Mutter which uses
GTK+ 2.x libraries can be used on many desktop
environments by installing the package mutter
through Synaptic Package Manager.
Stacking Window Managers
Afterstep

Compiz settings window under KDE
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Xfwm’s compositing in action

AfterStep is a stacking window manager, originally
based on the look and feel of the NeXTStep
interface, it provides end users with a consistent,
clean, and elegant desktop. The goal of AfterStep
development is to provide for flexibility of desktop
configuration, improving aesthetics, and efficient use
of system resources.
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Some of the distinguishing features of AfterStep
compared to other window managers are its low
usage of resources, stability and configurability.

supports running dockapps which make everyday
tasks such as monitoring system performance and
battery usage, mounting devices or connecting to
the internet very easy.

Afterstep on PCLinuxOS

You can find more info about Afterstep from the
official website: http://www.afterstep.org/
Afterstep is available in PCLinuxOS by installing the
package Afterstep through Synaptic Package
Manager.
Window Maker
Window Maker is an X11 window manager originally
designed to provide integration support for the
GNUstep Desktop Environment. In every way
possible, it reproduces the elegant look and feel of
the NEXTSTEP user interface. It is fast, feature rich,
easy to configure, and easy to use. It is also free
software, with contributions being made by
programmers from around the world.
Window Maker has a stable user interface since
many years and comes with a powerful GUI
configuration editor called WPrefs, which removes
the need to edit textbased config files by hand. It
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Window Maker on PCLinuxOS

You can find more info about Window Maker from
the official website: http://windowmaker.org/
You can use Window Maker in PCLinuxOS by
installing the package Windowmaker through
Synaptic Package Manager.
Enlightenment (E)
Enlightenment, also known simply as E, is a lean,
fast, modular and very extensible stacking window
manager for X11, which can be used alone or in
conjunction with a desktop environment such as
GNOME or KDE. Ιt is classed as a "desktop shell"
providing the things you need to operate your
desktop (or laptop), but is not a whole application
suite.
Enlightenment is known as a Window Manager, but
provides most of the functionality found in much
more resourcehungry Desktop Environments.

Beyond the window manager, the Enlightenment
project also provides a whole suite of libraries for
creating beautiful user interfaces with much less
work than doing it the old fashioned way and fighting
with traditional toolkits.

Enlightenment over KDE in PCLinuxOS

You can find more info about Enlightenment from the
official website: http://www.enlightenment.org/
Enlightenment is available in PCLinuxOS by
installing the package taskenlightenment through
Synaptic Package Manager.
Blackbox/Fluxbox
Blackbox is a fast, lightweight window manager built
with C++. Blackbox has specific design goals, and
some functionality is provided only through other
applications. It's designed to be fairly small and
minimal, making it particularly suited to less powerful
computers. It doesn't support images, other than
generated gradients, but it does support multiple
desktops and is NetWM compliant, making it
compatible with KDE and GNOME (next page).
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More info about those two window managers can be
found from the official websites:
http://blackboxwm.sourceforge.net/BlackboxWiki
http://www.fluxbox.org
You can use Blackbox and Fluxbox in PCLinuxOS
by installing the packages blackbox and fluxbox
(respectively) through Synaptic Package Manager.
Openbox

Blackbox on PCLinuxOS

Fluxbox started as a fork of Blackbox 0.61.1, with
the same aim to be lightweight. Its user interface has
only a taskbar, a popup menu accessible by right
clicking on the desktop and minimal support for
graphical icons. All basic configurations are
controlled by text files, including the construction of
menus and the mapping of key bindings. Fluxbox
has high compliance to the Extended Window
Manager Hints specification.

Fluxbox on PCLinuxOS
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Openbox is a lightweight and highly configurable
window manager with extensive standards support.
Originally derived from Blackbox 0.65.0, Openbox
has now been totally rewritten in the C programming
language and since version 3.0 is not based upon
any code from Blackbox. It is the default window
manager of the LXDE desktop environment.
Openbox uses the *box visual style and can be fully
customized with the use of themes. Its high
configurability means that it can suit almost any
user’s needs. It can be kept simple but can also be
tweaked in almost every aspect, completely
changing the way the users interact with their
desktops.

Openbox configuration under LXDE

Openbox can run inside other desktop environments
but can also be used without any desktop
environment or session manager.
You can find more info about Openbox from the
official website: http://openbox.org/wiki/Main_Page
You can use Openbox in PCLinuxOS by installing
the package openbox through Synaptic Package
Manager.
IceWM
IceWM is a stacking window manager for the X
Window System graphical infrastructure, written by
Marko Maček. It was coded from scratch in C++ and
is released under the terms of the GNU Lesser
General Public License. It is relatively lightweight in
terms of memory and CPU usage, and comes with
themes that allow it to imitate the GUI of Windows
95, OS/2, Motif, and other graphical user interfaces.
IceWM is meant to excel in look and feel while being
lightweight and customizable.
IceWM can be configured from plain text files stored
in a user's home directory, making it easy to
customize and copy settings. IceWM has an

IceWM on PCLinuxOS
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optional, builtin taskbar with menu, tasks display,
network and CPU meters, mail check and
configurable clock. Official support for GNOME and
KDE menus was previously available as a separate
package. In recent IceWM versions, support for
them is embedded. External graphical programs for
editing configuration and menu exist.

Metacity can be used either in conjunction with
GNOME 2 Desktop Environment or by installing the
package metacity through Synaptic Package
Manager.

You can find more info about IceWM from the official
website: http://www.icewm.org/

Twm (Tab Window Manager, or sometimes Tom's
Window Manager, after the principal author Tom
LaStrange) provides titlebars, shaped windows,
several forms of icon management, userdefined
macro functions, clicktotype and pointerdriven
keyboard focus, and userspecified key and pointer
button bindings.

IceWM can be used in PCLinuxOS by installing the
package icewm through Synaptic Package
Manager.
Metacity
Metacity was the window manager used by default
in the GNOME 2 desktop environment until GNOME
3, where it was replaced by Mutter. A fork, renamed
to "Marco", is still being actively developed and
maintained as part of the MATE desktop
environment, itself a fork of GNOME 2 as a whole.
The development of Metacity was started by Havoc
Pennington and it is released under the GNU
General Public License. Before the introduction of
Metacity
in
GNOME
2.2,
GNOME
used
Enlightenment and then Sawfish as its window
manager. Although Metacity is part of the GNOME
project and designed to integrate into the GNOME
desktop, it does not require GNOME to run, and
GNOME can be used with different window
managers provided that they support the part of the
ICCCM specification that GNOME requires.
Metacity uses the GTK+ graphical widget toolkit to
create its user interface components, which makes it
themeable and makes it blend in with other GTK+
applications.
You can find more info about Metacity in this blog:
http://blogs.gnome.org/metacity/2007/12/23/start
readinghere/
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twm

It has, however, been left behind by more recent
window managers, making it something of mainly
historical interest. It was for some time the only real
choice of window manager, after taking over from
the very simplistic uwm. Nearly every window
manager since has borrowed heavily from it, either
directly, or indirectly through other window
managers, such as fvwm.

You can find more info on LaStrange’s home page:
http://www.lastrange.com/work/
twm can be used in PCLinuxOS by installing the
package twm through Synaptic Package Manager.
Fvwm
Fvwm, a stacking window manager developed by
Robert Nation, was once dominant in the window
manager stakes, especially in the Linux community.
It borrows heavily from Tom LaStrange's famous
twm window manager, which was the first ICCCM
compliant window manager to be written. It requires
some effort to learn to use it well, since it is almost
entirely configured by editing configuration files with
a text editor. But those who persist end up with a
desktop environment that works exactly the way
they want it to work. Development is active, and
support is excellent.
Fvwm was designed to minimize memory
consumption, provide a 3D look (similar to Motif's
mwm) and provide a simple virtual desktop.
Functionality can be enhanced by the use of various
modules.

twm on PCLinuxOS

The source code is no longer developed, but old
TWM archives for various releases of X are
available.

Fvwm on PCLinuxOS

Page 15

Windows Migration: Desktop Environments & Window Managers
You can find more info about fvwm from the official
website: http://www.fvwm.org/
Fvwm can be used in PCLinuxOS by installing the
package fvwm through Synaptic Package Manager.
PekWM
PekWM is a stacking window manager for the X
Window System, written in C++ by Claes Nästen,
and highly configurable. The code is based on the
aewm++ window manager, but it has evolved
enough that it no longer resembles aewm++ at all. It
also has an expanded featureset, including window
grouping (similar to Ion3, PWM, or Fluxbox), auto
properties, xinerama and keygrabber that supports
keychains, and much more.

Tiling and Dynamic Tiling Window Managers.
wmii
wmii (window manager improved²) is a tiling window
manager that supports classic and tiling window
management with extended keyboard, mouse, and
filesystem based remote control. It replaces the
workspace paradigm with a new tagging approach.
The window manager offers extensive configuration
through a virtual filesystem.

name "Ratpoison" reflects its major design goal: it
lets the user manage application windows without
using a mouse. Unlike other tiling window managers
like Ion, ratpoison completely ignores the mouse,
and avoids window decorations as much as
possible. It behaves like the terminalmultiplexer
GNU screen. Every window is maximized to fit the
whole screen, no pixel is wasted on stuff like borders
or other decoration. The user can also "split" the
screen into two or more frames in order to display
more than one window at a time.

In its latest release, wmii supports Xinerama and
ships its own keyboardbased menu program called
wimenu, featuring history and programmable
completion.

A screenshot of Ratpoison

A screenshot of PekWM in action.

You can find more info about PekWM from the
official
website:
https://www.pekwm.org/projects/pekwm
PekWM can be used in PCLinuxOS by installing the
package pekwm through Synaptic Package
Manager.

wmii on PCLinuxOS

More info about wmii from its page on Google
Project Hosting: https://code.google.com/p/wmii/
wmii can be used in PCLinuxOS by installing the
package wmii through Synaptic Package Manager.
Ratpoison
Ratpoison is a minimalistic window manager which
can be controlled 100% through the keyboard. The
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You can find more info about Ratpoison from the
official website: http://www.nongnu.org/ratpoison/
Ratpoison can be used in PCLinuxOS by installing
the package ratpoison through Synaptic Package
Manager.
dwm
dwm is a dynamic tiling window manager for X11
exhibiting the principles of minimalism which is
known for having influenced the development of
other window managers, including xmonad and
awesome. It is externally similar to wmii, but
internally much simpler. dwm is written purely in C
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and, for simplicity, lacks any configuration interface
besides editing the source code. One of the project's
guidelines is that the source code will never exceed
2000 lines, and options meant to be user
configurable are all contained in a single header file.

any people dealing with everyday computing tasks
and who want to have finegrained control on theirs
graphical environment.

dwm is a dynamic window manager for X. It
manages windows in tiled, monocle and floating
layouts. All of the layouts can be applied
dynamically, optimising the environment for the
application in use and the task performed.

awesome on PCLinuxOS

You can find more info about awesome from the
official website: http://awesome.naquadah.org/

dwm on PCLinuxOS

awesome
awesome is a dynamic window manager for the X
Window System developed in the C and Lua
programming languages. The latter is also used for
configuring and extending the window manager. Its
development began as a fork of dwm. It aims to be
extremely small and fast, yet extensively
customizable and make it possible for the user to
productively manage windows with the use of
keyboard.
awesome is highly configurable, very fast, extensible
and licensed under the GNU GPLv2 license. It is
primarily targeted at power users, developers and
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awesome can be used in PCLinuxOS by installing
the package awesome through Software Package
Manager.
Conclusion
There are a lot more Desktop Environments and
Window Managers out there, that are either forks of
existing ones or are not being maintained anymore.
This article can’t list them all, but I hope it has
covered at least the most well known and popular
ones. And, of course, I hope it has given you a good
idea of what “freedom of choice” really means in the
world of Linux, and in the world of PCLinuxOS!
Advertisement

Available in the following desktops:
KDE

LXDE

Openbox

Xfce

Gnome

Enlightenment e17
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Windows Migration: One Installation,
Two (Or More) Desktop Environments

by Paul Arnote (parnote)

As Antonis pointed out in his article, there are
several desktop environments and window
managers to choose from when you use Linux.
PCLinuxOS has many that you can choose from.
But how do you know which one is right for you and
your computing needs?
Certainly, you can try out each of the Live CDs
available for PCLinuxOS. That will help you choose
between running the KDE, LXDE and Xfce desktop
environments as your main choice. But if you are
new to Linux, it’s sometimes hard to know which one
will provide you with the environment that works best
for you in a given situation. Don’t fret. This is an
easy situation to overcome. We all realize that you
aren’t faced with such choices with the commercially
available operating systems, such as Microsoft
Windows and Apple’s OSX. Having that choice is
part of the charm of Linux. Linux is all about having
a choice.
The choice is easy if you are merely trying to choose
between those desktop environments that have Live
CDs. But that only begins to scratch the surface of
possibilities. What if you can’t decide between the
KDE and LXDE desktop environments? What if you
are interested in trying out one of the “other” desktop
environments (FluxBox, Enlightenment, Openbox,
etc.) that don’t currently have Live CDs? Believe it or
not, in either case, you don’t have to choose. You
can have them both … or all of them, if you choose.
KDE & LXDE … Have Them Both
To illustrate how simple this is, I made a separate
installation of KDE in VirtualBox (image below).
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Once you have KDE installed, fully updated your
KDE installation. Reboot your computer after fully
updating, just to be sure that your computer is
utilizing all the current software. This entire process
is the same when the installation is on “bare metal”
computer hardware.

Once you’ve rebooted, open Synaptic and search for
“tasklxde.”
Right click on “tasklxde” and select “Mark for
installation” from the right click context menu.
Advertisement

Synaptic will show you a list of additional packages
that will need to be installed in order to install LXDE.
The same thing applies with any of the additional
desktop environments you might wish to install – I
just chose LXDE for the demonstration. Select
“Mark” in the above dialog box, and then the “Apply”
button to install your new desktop environment.
Once the installation of your additional desktop
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both open on the desktop. Notice the difference in
the window decorations.

environments is complete, Log Out of your current
session.

The choice of running KDE with a lighter weight
window manager may allow you to successfully run
KDE on hardware that may otherwise not be
capable of running a “regular” KDE installation
without noticeably bogging down.
Summary

desktop environment are installed. This gives you
more options for many tasks.

Click on the blue arrow at the bottom of the session
login screen. You will see an option menu, like that
shown in the image above. Select the desktop
environment you want to run in the new session.
Next, select the user account to log into, and provide
the user password.
Upon logging back in, notice how our desktop
environment has changed to LXDE. You are now
using a full LXDE desktop environment.
There are some additional benefits to having two
different desktop environments installed on your
PCLinuxOS installation. First, all of the associated
and default programs that accompany the extra
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Second, if you look back up to the session menu,
you will notice some additional choices. For
example, you can now run KDE with the Openbox
window manager. Normally, KDE uses the KWin
window manager, but the Openbox window manager
was installed with LXDE, since that is the window
manager that LXDE uses. This provides you the
choice of running KDE with a lighter weight window
manager than what it normally runs. In the previous
image, KDE is running with the Openbox window
manager, and shows both Dolphin and PCManFM –
the file managers for KDE and LXDE, respectively –

As you see, Linux is full of choices. If you are new to
Linux, this is something else you will have to get
used to – although it is a very nice change,
especially once you become accustomed to it. No
longer are you locked into one way of doing things,
with a “onesizefitsall” graphical user interface.
With Linux, your personal computer truly becomes
“personal,” since you have so many ways to
customize and personalize your computing
experience.

A magazine just isn't a magazine
without articles to fill the pages.
If you have article ideas, or if you
would like to contribute articles to the
PCLinuxOS Magazine,
send an email to:
pclinuxos.mag@gmail.com
We are interested in general articles
about Linux, and (of course), articles
specific to PCLinuxOS.
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It's easier than E=mc2
It's elemental
It's light years ahead
It's a wise choice
It's Radically Simple
It's ...

Posted by µT6, March 5, 2013, running KDE.
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Mark's Quick Gimp Tip & Double Take

Mark's Quick Gimp Tip

This month's GIMP tip is pretty
obvious,
but
nonetheless,
needs to be pointed out from
time to time. My tip is simply
this:
when
editing
a
photo/picture/artwork,
make
each edited element its own separate layer.
Too often, new users start in using GIMP and
make the common mistake of placing all their
edits and changes on the same layer. When
I was first learning to use graphics
applications, I made this common mistake far
too many times.) In my example below, you

can see how I edit my feature “I
Knew That!” Each element is its
own layer.
The artwork,
question, answer, signature, etc.
are each on its own layer. I can
then
move
each
layer
independently without disturbing
the other elements. I can also
rearrange the layer order if I
want to drop an element in front
or behind another.
Mark Szorady is a nationally
syndicated cartoonist with
georgetoon.com. He blogs at
georgetoon.com/blog.
Email Mark at
georgetoon@gmail.com.

©2013 by Mark Szorady. Distributed by georgetoon.com
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ms_meme's Nook: Too Good To Be True

It's just too good to be true see what Texstar made for you
It's like heaven to boot it's great there is no dispute
At last PCLOS arrived and I thank Tex it's alive
It's just too good to be true feels like deja vu

Pardon the way that I smile how very sweet the compile
Blue bulls sweep me off of my feet oh my what a treat
So come join in this bliss you don't want to miss
It's just too good to be true others it does outdo
I love you Linux you always treat me right
I need you Linux I use you day and night
I trust you Linux in every way
MP3
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OGG

Get PCLOS now don't delay

You'll love PCLOS with its blue display

And give thanks to Tex each and every day
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Inkscape: Starting Your First Project
by Meemaw
We have gotten familiar with the Inkscape window
and some of the tools. Let’s make something!
If you already have Inkscape open, you have a new
page. Click on the Document Properties button
(the last one on the right in the Command Bar). In
the window, change the page orientation to Portrait,
then change width to 900 px and height to 1200 px
to make it a custom size. If it is not checked, check
Show Page Border at the bottom of the window. I
have also checked Show Border Shadow, but you
don’t have to check that one. The border helps me
see the edges of my page. I think that’s default
anyway. Remember, after you get accustomed to
things you can set them up as you desire.
Close that window and you should see this:

Notice that the rulers are across the top and up the
left side. Also notice that the left side ruler counts up
from the bottom of the page. Page location
measurements in Inkscape start from the bottom left.
Now we have plenty of room to work.
OK, let’s draw. Choose the ellipse, then click and
drag your mouse. Click on a color in the pallette
down at the bottom of the window, and your ellipse
should now be filled with that color. Holding <Shift>
and clicking a color will make the Stroke (Border)
that color, and probably 1 or 2 pixels wide. You can
right click
the number
and make
the Stroke 2
if it is
another size.
I chose a
blue for fill.

We’re going to make a simple picture
in a frame. Click on Edit > Duplicate
or use the keys <CTRL> + D. You
won’t see it right away because it is
the same as the ellipse you have.
Click on the Fill & Stroke button in
the Command bar at top, and your
Fill & Stroke Window will appear.
Change the fill on this new ellipse to
none by clicking the button with the X
(at the top of the fill & stroke window
above the color wheel, or in the
palette at the bottom), and change
the stroke to 6 (top, right).
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Now we are going to make this ellipse bigger. Click
on Path > Outset or <CTRL> + ). Your ellipse will
enlarge by 2 pixels, which is the program default.
You can do the same command or Key combination
as many times as you want to enlarge the ellipse
until it is outside the blue ellipse. Mine looks like this:

Now do the same thing again (duplicate and
enlarge), only this time make our stroke width 15
(next page, top).
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using the slider at the bottom, then click on Filters >
Blurs > Fancy Blur.
Now click on the outer stroke. change it to a similar
brown color, the opacity to 100, and make sure the
stroke size is still 15. Go back to Filters and this
time choose Bevels > Dark Glass. Your image
should now look similar to the following:

project and choose Edit > Duplicate (or <CTRL> +
D). Click on the duplicate and move it over by your
photo. Change the Fill to None, and the Stroke size
to 2. If one of the items is smaller, size each until
both objects are close to the same. My photo is
taller, which is OK, but I need it to be at least as
wide as the ellipse. Holding the <CTRL> as I size
will preserve the aspect ratio of the photo.

Before we go any farther, let’s make sure everything
is lined up correctly. Position your mouse out from
the drawing, then click and drag a rectangle around
it. This will select everything inside the box you draw.
Then click on the Align & Distribute button in the
command bar. Click on both Center Vertically and
Center Horizontally to make sure everything is
centered.
I have opened a copy of the photo I colorized earlier.
I want to put it inside the frame. Since it is saved as
a png, you will need to Import it (File > Import).
When you have chosen your photo to import, you
will be asked if you want to Embed or Link the photo.
Embedding adds the file to your project, and will
make your file bigger. Linking will link the file to your
project without increasing the size, but if you save
your project to another location, you will have to
save any linked files there too. I usually embed
anything I import so it is all there together.
Click on the Fill & Stroke tool at top. When the
window pops up, choose the inner stroke. Change
the color to a brown color and the opacity to 100
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Before we proceed, click on the ellipse and duplicate
it, then set it aside for later use. We’re going to use
the Clip tool. Click on the ellipse FIRST, then hold
down <Shift> and click on the photo. That selects
the photo without deselecting the ellipse. Go to
Object > Clip > Set. When you do that, your two
items should be cropped to the inside of the ellipse.

This photo is rectangular and I want it to be oval, so
we’re going to make it oval. You can place your
photo off to the side of the main project so we can
edit it. Click on the ellipse in the center of your
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I’m going to place the ellipse I just set aside over the
photo for a border. You can select them both, like we
just did, then center them both ways.
You can Group these so you won’t have to align
them again. I selected my ellipse, made sure the
opacity was 100% and changed the blur to 1 before I
grouped. It just softened the border.

You can move the photo into your frame, but I like
the blue color and I’m going to resize my photo just
a bit so a little of the blue is visible around the photo.
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To preserve the aspect ratio of the photo, I will hold
down <CTRL>. Before we do anything else, click on
your photo or ellipse with the color in it and duplicate
it once more. Slide it to the side of your project. After
that, you should select everything by drawing a box
around it all, or by clicking on the selection buttons
at the left end of the second tool bar. The one that
looks like a stack of papers and says “Select all
objects in all visible and unlocked layers” is the one
you want. Hold down <Shift> and deselect the
ellipse we just created and stored to the side of our
drawing. Then use your Align & Distribute tool to
center everything else one more time. If you are
satisfied with your work so far, you can also group
everything so you don’t have to align it any more.
You should also be saving your work (bottom, left).
OK, let’s do one more thing with that extra ellipse.
Most picture frames have glass on the front to
protect the photo. Let’s give the impression of a
glass front. Make the fill on that ellipse a Linear
Gradient, and the Stroke size a 1, just so you can
see your edge. Using your Fill & Stroke window,
click on linear gradient in the fill tab, and make it
white. Your ellipse will immediately change so it’s
white on one side and transparent on the other side.
We’re going to change that. Click on Edit... in that
window, and you will see another window pop up.
Also, go to your left side toolbar and click on the
Gradient button (towards the bottom). You should
now see a line crossing your ellipse that has a small
square on one end and a small circle on the other.
These are called Stops. We are going to add a few
more. In the newest window, click on the Add Stop
button five times. Each time you click, you should
see another small square appear on the line. Five
clicks, five squares. They will not be evenly spaced
across the line, so you should click & drag them, one
at a time, until they are closer to evenly spaced. It
doesn’t have to be perfect, though, since light and
shadow makes things look uneven at times.

In your Edit box, there is a dropdown with the stops
numbered. One at a time, choose every other stop,
and slide the color slider below the color wheel
towards transparent. It will look similar to this:

If there is too much white when you finish you can
always go back to your Fill & Stroke window and
set the opacity down to 45% or so. Experiment with
your gradient until you get it the way you want it.
When you are satisfied with that you can group
everything together and save.
As one last thing, let’s choose Filters > Shadows &
Glows > Drop Shadow. We will get another
configuration window. It asks for Blur Radius,
Opacity, and Horizontal and Vertical Offset. I think
the default is 4 px, 30% opacity and 3 px for each
offset. I left the defaults. The buttons at bottom are
Apply and Close. When you click Apply, the drop
shadow will be added where you configured it. If you
don’t think the shadow is pronounced enough, click
Apply again. (I think I clicked twice.) The worst that
can happen is that you get too much and have to
undo it (<CTRL> + Z). Do it the way you like it. It is,
after all, YOUR creation (next page).
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The place where breaking news,
BitTorrent and copyright collide

Screenshot
Screenshot Showcase
Showcase

After you save it, you can export a bitmap from the
file menu and save it as a png, jpg, or other image
file.
It’s really amazing what you can do with several
copies of the same ellipse and a photo. I’m sure with
a little experimentation, you can make any number
of wonderful items.

The
PCLinuxOS
Magazine
Created with
Scribus 1.4.1
PCLinuxOS Magazine

Posted by dalefritz, March 4, 2013, running Blackbox.
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Xfce Power User Tips, Tricks & Tweaks:
Archive File Management

by Paul Arnote (parnote)

members, coworkers, associates and anyone else
that you might want to share files with.

If you’ve been around or worked with computers for
any length of time, you’ve certainly had to work with
archive files, bearing such filename extensions as
zip, tar.gz, tar.bz2, xz, 7z, rar, etc. In fact, you might
have even had to create a few (or a few thousand)
yourself. Without a shadow of a doubt, you’ve had to
extract the information from an archive file that a
friend or family member sent you, or that you
downloaded from some corner of the Internet.

Most archive formats compress the files in the
archive, allowing you to store those files in less
space on your hard drive. Other archive formats
don’t compress the files at all. Their “job” is to just
keep all of the files together, in one convenient spot.
We’re not going to discuss the different archive
formats in any detail here. This article isn’t intended
to be a tutorial about the various archive file formats.
That information is readily available and easy to find,
and goes into much more detail than is necessary
for our needs here.

individually in a typical archive manager program,
though. As good as those programs are, there are
times when I simply want to take a brief peek into
the archive file without having to launch my trusty
archive manager program. Sometimes, I want to
simply create an archive file. Other times, I simply
want to extract an archive file to my hard drive,
without even looking to see what’s inside (I receive
many archive files every month from trusted
sources).
As an Xfce desktop user, I have some “other”
choices for how to deal and work with archive files.
Thanks to Thunar’s Custom Actions, even more of
those choices are available to me with only one or
two clicks of the mouse. If you are not a Xfce user,
don’t worry. A lot of the information in this article can
be used from the command line as well, with minor
modifications in some cases, and virtually no
modification in other cases.
The Native Xfce Solution

The assorted archive formats have been around
since … well … forever. They are very useful for
placing a multitude of files – related or not – into one
file. This makes it easier to keep things organized –
one file to keep track of, instead of 147. They also
help to keep associated and related files together, so
that the recipient has everything all in one file. It also
makes it easier to share files with friends, family
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File Roller displaying the contents of a tar.gz file
Linux is blessed enough to have several choices.
Ark, File Roller and Squeeze are three popular
programs with excellent graphical user interfaces.
There are many more command line programs
available for dealing with the assortment of archive
file formats floating around out there. I have to admit
that it gets tiresome to open each archive file

Fortunately, the Xfce developers have included a
plugin for Thunar that assists with working with
archive files. Unfortunately, in the four years I’ve
been using mostly Xfce as my main desktop, that
plugin would break, they would fix it, then it would
break again, then they would fix it again. On and on
this cycle seems to go, without an end in sight. As a
result, I’ve lost confidence in using the Thunar
archive plugin. In fact, I’ve uninstalled it from my
computers, to prevent being disappointed the next
time it breaks (and to prevent confusing it with my
home brewed solution, below).
So, as much as I hate to admit it, I don’t recommend
using the Thunar archive plugin. If you’re like me,
you need something that performs properly, every
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time out of the gate. I don’t want to have to worry
whether everything made it into the archive file. I
need unfettered dependability, and something that
works consistently – every time.
An Alternative Solution
Since archive files have been around forever, there
are many other tools available to help me deal and
work with them. All of the individual archive file
formats has its own command line tool for working
with them. Some have two tools to use, depending
on if you are creating or extracting an archive.
Of course, no two command line tools could possibly
have the same command line switches, so you have
to remember different command line switches for
every tool you use, which quickly gets confusing and
cumbersome. Granted, using the dedicated
command line tool for a particular archive file format
gives you the most control over your archive file
formats and any work you need to perform with (or
on) them. But those dreaded command line
switches ….
Of all of the tools available, I’ve stumbled upon one
that truly makes working with archive files easy and
painless. It is a command line tool, called atool.
Currently up to version 0.39.0, atool is a collection of
Perl scripts that provide a common set of commands
for dealing with every type of archive file supported
on your system. Thus, you have but only one set of
command line switches to remember, rather than a
different set for each and every archive tool.
You can install atool from the PCLinuxOS repository,
via Synaptic. This would also be a good time to
install any other archive formats you wish to work
with – or think that you might encounter. If you want
to work with 7z files, you will want to install p7zip. If
you want to work with rar files, you will want to install
rarlinux. Most of the more common archive tools
(zip, unzip, tar, gzip, bzip, etc.) should already be
installed on your PCLinuxOS installation.
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Here are the command line options, gathered up for you by running atool help at the command line:
atool help
Usage: atool [OPTION]... ARCHIVE [FILE]...
atool e [OPTION]... [ARCHIVE]...
Manage file archives of various types.
Commands:
l, list
x, extract
X, extractto=PATH
a, add
c, cat
d, diff
r, repack
help
version

list files in archive (als)
extract files from archive (aunpack)
extract archive to specified directory
create archive (apack)
extract file to standard out (acat)
generate a diff between two archives (adiff)
repack archives to a different format (arepack)
display this help and exit
output version information and exit

Options:
e, each
F, format=EXT
O, formatoption=OPT
D, subdir
f, force
q, quiet
v, verbose
V, verbosity=LEVEL
p, page
0, null
E, explain
S, simulate
o, option=KEY=VALUE
config=FILE

execute command above for each file specified
override archive format (see below)
give specific options to the archiver
always create subdirectory when extracting
allow overwriting of local files
decrease verbosity level by one
increase verbosity level by one
specify verbosity (0, 1 or 2)
send output through pager
filenames from standard in are nullbyte separated
explain what is being done by atool
simulation mode  no filesystem changes are made
override a configuration option
load configuration defaults from file

Archive format (for format) may be specified either as a
file extension ("tar.gz") or as "tar+gzip".
Report bugs to Oskar Liljeblad <oskar@osk.mine.nu>.

Notice how some of the commands have a separate command listed in parenthesis at the end of the line of
text in the help statement. The really nice thing is that you can use the atool command, or you can direct your
commands straight to the command that atool will ultimately use and call. There are six separate commands
(other than atool) that you can use:
als  lists files in an archive
aunpack  extracts files from an archive
apack  adds files to an archive

acat  extracts files to standard output
adiff  generates a diff between two archives
arepack  converts from one archive format to another
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We’ll use three of these commands (als, aunpack
and arepack), along with the atool command, in our
Thunar Custom Actions. These four commands will
cover 99.9% of the archive file management tasks
that most users will need to perform. If you have or
find a need for any of the others that we didn’t use,
please feel free to use the information here to help
tailor your own Thunar Custom Action to perform
your desired task. Plus, if you develop a Thunar
Custom Action using any of the “other” atool
commands, please drop me a note about it at
pclinuxos.mag@gmail.com.
Listing The Contents Of Archive Files
Sometimes – ok, often times – the name of an
archive file is a bit less descriptive of its contents
than you might like it to be. This can make it difficult
to figure out what’s in the archive file, unless you
open it up in the resident archive manager. However,
we can take a peek at the files in an archive file
much more easily, and with less overhead.
Create a new Thunar Custom Action. Give it a name
on the first line. I called mine “View Archive
Contents.” On the second line, enter a description. I
entered “View the contents of the selected archive
file.” On the third line, enter the following command:
als l e %N | zenity textinfo
width=800 height=300 title="Archive
Contents"

Choose an icon for your new Thunar Custom Action.
Under the “Appearance Conditions” tab, select
“Other Files” and set the file pattern to
*.tar.gz;*.tar.bz2;*.7z;*.rar;*.zip; *.tar;*.tar.xz.
Now, whenever you select “View Archive Contents”
from Thunar’s rightclick context menu, you will see
a dialog box similar to the one above, with the
contents of the archive files listed in the dialog box.
You can select multiple files in Thunar, and the
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contents of all the archives will be displayed in the
dialog box, one after another.
Unpacking/Extracting Archive Files
Probably one of the most common activities when
working with archive files is extracting the archive
contents to your hard drive. For being able to extract
files from the wide assortment of archive files, this
activity begs – no, cries out – for some simplification.
Sure, you could write a bash file that handles all the
different archive file formats, but thanks to atool, we
don’t have to.
One of the commands that makes up the atool
“suite” (it really is a suite of Perl scripts) is the
aunpack command. As you can see in the “Edit
Action” Thunar Custom Action dialog box above, we
give it the name “Extract Archive Here.” Under the
description, enter “Extract the selected archives here
into their own directories.” Then, enter the following
command:
aunpack xe %N

Choose an icon for your new Thunar Custom Action.
Under the “Appearance Conditions” tab, select
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“Other Files,” and enter the following as the file
pattern to match:
*.zip;*.tar;*.tar.gz;*.tar.bz2;*.rar;*tar.xz;*.7z
Now, whenever you select “Extract Archive Here”
from Thunar’s right click context menu, your selected
archive files will be extracted, each to their own
individual directory. This is one of the added benefits
of using atool’s aunpack command. The extraction of
the archive file’s content is automatically placed into
its own directory, and you actually have to force the
atool suite of commands to overwrite files. Thus, you
get an extra layer of “safety” that prevents any of
your current files from being overwritten. With that in
mind, if you have extracted the files from an archive
file previously and wish to repeat that action, it might
be a good idea to rename the folder to where the
archive file’s contents were extracted the first time.
Creating Archive Files
To fully replace the Thunar archive plugin, I had to
find a way to an create an archive file from multiple,
noncontiguous files, as well as being able create an
archive file from an entire directory. Luckily, the
atools suite of commands provided just that. Plus,
since we’re creating a file, we need a way to give
that file a name.
The easiest way to satisfy all of the requirements is
to create a bash file. Here is that bash file, which I
have called compressor.sh (top of next column).
This bash file has had a few other versions before
getting to the version you see here. Looking at it
again, I notice that we can make the bash file even
shorter by completely eliminating the long ifthen
else statement where it checks for a proper archive
file format extension. From that long statement, we’ll
save only the atool command. Previous versions
had the user entering the archive file extension
manually, instead of selecting it from a list (as this
version has you do). The long if statement helped to
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#! /bin/sh
ARCHIVE=`zenity title="Archive name" entry entrytext=”$(echo $1 | cut f1 d.)” 
text="Enter the archive name ONLY:"`
if [ $? == 1 ]; then
exit
fi
TYPE=$(zenity list column="Select One" title="Create Archive" width=200 
height=250 text="Select the archive format to use" zip tar tar.gz tar.bz2 7z rar
tar.xz)
if [ $? == 1 ]; then
exit
fi
if [ $TYPE == "tar.gz" ] || [ $TYPE == "tar.bz2" ] || [ $TYPE == "tar" ] || [ $TYPE ==
"zip" ] || [ $TYPE == "rar" ] || [ $TYPE == "7z" ] || [ $TYPE == "tar.xz" ]; then
atool a format $TYPE “`echo ./$ARCHIVE.$TYPE`” “$@”
else
zenity info title="Error" text="Unrecognized archive format specified. Exiting."
fi
exit 0

check if the archive file extension was properly entered without typos, and if it wasn’t, to display an error
message and exit. Since the end user is selecting the archive file extension from a list, we’ve eliminated the
possibility of entering an improper file extension. As a result, the error message box will never, ever be
displayed.
So, with those changes, the compressor.sh bash file becomes this:
#! /bin/sh
ARCHIVE=`zenity title="Archive name" entry entrytext=”$(echo $1 | cut f1 d.)” 
text="Enter the archive name ONLY:"`
if [ $? == 1 ]; then
exit
fi
TYPE=$(zenity list column="Select One" title="Create Archive" width=200 
height=250 text="Select the archive format to use" tar.gz tar.bz2 tar.xz zip tar 7z
rar)
if [ $? == 1 ]; then
exit
fi
atool a format $TYPE “`echo ./$ARCHIVE.$TYPE`” “$@”
exit 0

Page 30

Xfce Power User Tips, Tricks & Tweaks: Archive File Management
belongs. Whenever possible, you should avoid using
spaces in filenames. Hence, if you are typing in this
bash script, be extra careful with what quotes you
are using throughout the bash script. “” is not the
same as ‘’, and neither are the same as ``. They all
have different meanings in a bash script. Type (or
copy) the bash script into your favorite plain text
editor, and be sure to save it (preferably somewhere
within your system’s path). Don’t forget to make the
file executable (Properties > Permissions > Allow
this file to run as a program).

“Appearance Conditions” tab, leave * as the file
pattern, and place a checkmark in front of every file
type.
Now, when you right click on a group of files or a
directory and select “Create Archive” from the
Thunar right click context menu, an archive of the
name you specify and of the type you specify will be
made in the current directory.
Repacking An Archive
This handy command is rather unique. It will take the
archive files you specify (multiple files are allowed)
and it will repackage them into a different archive file
format. Let’s say you have a tar.gz archive file
containing images from your recent vacation. You
want to share them with your sister, cousin and
parents. However, they all use Windows, and
everyone knows that zip files “rule” on Windows. To
be sure that they can open and view the images,
you need to change the tar.gz file to a zip file.

The bash file also preselects a filename for you,
based on the first filename passed to the script. If
you have selected multiple files, then the name of
the first file in the list of files is automatically filled
into the archive name dialog box, stripped of its file
extension. If you have selected a directory to
compress, then the name of the selected directory is
automatically filled into the archive name dialog box.
In either case, if you want to name it something else,
simply type the preferred name into the archive
name dialog box.
Although using spaces in filenames shows bad form,
I’ve attempted to create this bash script to be
tolerant of spaces in filenames. Spaces in filenames
can cause problems with many command line tools,
the group of programs to which atool definitely
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Sure, you could just extract the tar.gz file and re
compress it as a zip file. But that involves quite a few
extra steps. What if we could just automagically
change the tar.gz file to a zip file in just one easy
step? With the atool suite, it is possible.
To properly handle multiple archive files and to
properly rename the files, a bash script becomes
necessary. Here is the bash script, which I’ve named
archiverepack.sh (next page).
Enter “Create Archive” as the name. Under the
description, enter “Create an archive file from a
group of selected files or a directory.” Enter the
following command on the third line:
$HOME/Scripts/compressor.sh %N

(I store all of my custom scripts in my /home
directory, under a “Scripts” directory). Select an icon
for your new Thunar Custom Action. Under the

Just as with the compressor.sh bash script, I’ve
attempted to make the archiverepack.sh bash script
tolerant of filenames with spaces in them. I won’t
belabor the previous discussion about spaces in
filenames here, again. The same statements made
earlier still stand.
Copy or type in the archiverepack.sh bash script in
your favorite plain text editor. Save the file, and don’t
forget to make it executable. Create a new Thunar
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#! /bin/sh
n=1

TYPE=$(zenity list column="Select One" title="Repack Archive" width=200 
height=250 text="Select the archive format to use" tar.gz tar.bz2 tar.xz zip tar 7z
rar)
if [ $? == 1 ]; then
exit
fi
for file in "$@"; do
if [ ! e "$file" ]; then
continue
fi
name="$(echo $file | cut f1 d.)"
atool r format $TYPE "$file" "`echo $name.$TYPE`"
echo $(($n * 100 / $#))
echo "# Processing file: $file"
let "n = n+1"

done | (zenity
autokill)

progress title "ReCompressing..." percentage=0 autoclose 

exit 0

Now, when you select “Repack Archives” from the
Thunar right click context menu, the selected archive
files will all be repackaged into the archive file format
that you select. A Zenity dialog box displays the
progress through the process.
Summary
The addition of these four new Thunar Custom
Actions not only adds new capabilities to archive
management with Thunar, but it also completely
replaces the oftenbreaking Thunar archive plugin.
Managing your archive files has never been so easy.
Looking for an old article?
Can't find what you want? Try the
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searchable index!

archive files to another archive file format.” On the
third line, enter the following command:
$HOME/Scripts/archiverepack.sh %N

Custom Action. On the first line, enter a name. I
called mine “Repack Archives.” On the second line,
enter a description. I entered “Repack the selected
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Select an icon for your new Thunar Custom Action.
Under the “Appearance Conditions” tab, select
“Other Files,” and set the file pattern to this:
*.zip;*.tar;*.tar.gz;*.tar.bz2;*.rar;*tar.xz;*.7z
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How Do I Kill A Program Under LXDE?
by Daniel MeißWilhelm (leiche)
What can you do when a program, such as Firefox,
starts consuming RAM memory? In the PCLinuxOS
forums, a user asked about a tool named memlockd,
because Firefox had been quickly using extra
resources and thrashing his HD. Memlockd gives a
quick access to TTY, where he can use the
command "killall firefox." However, we can use a
faster method, without resorting to the use of
memlockd.
Copy and paste the following desktop file as
kill_firefox.desktop:
[Desktop Entry]
Encoding=UTF8
Name=killall firefox
Name[de]=Töte Firefox
Exec=killall firefox
Icon=exec.png
Terminal=false
Type=Application
StartupNotify=true
Categories=Infos;System;Monitor;X
MandrivaLinuxSystemMonitoring;

I pushed <ctrl>+<alt>+<0>.

OR
If you have xbindkeys running, ps e | grep
xbindkeys will display it. You can add a shortcut with
it. For example, xbindkeys k.

"(Scheme function)"
m:0xc + c:19
Control+Alt + 0

Save it on your Desktop. If Firefox misbehaves, click
it.
OR

Add this to your $HOME/.xbindkeysrc:

Save it under $HOME/.local/share/applications. It
will now be displayed in Start > More Applications >
Monitoring.
Now can you add it in your lxpanel. Right click on
the panel, and choose add/remove panel items,
look at application launch bar, click on edit and
choose Kill Firefox.
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Press your desired combination of keys or/and click
under the window. You can use one of the two lines
after "NoCommand" in $HOME/.xbindkeysrc to bind
a key.

# killing firefox
"killall firefox"
m:0xc + c:19
Control+Alt + 0

Now, restart xbindkeys. In a terminal, enter killall
xbindkeys && sleep 1 && xbindkeys.
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Advanced Linux Sound Architecture (ALSA) Equalizer
by Yankee
Why would we need to install Pulse Audio to be able
to enjoy a systemwide audio Equalizer utilizing the
ALSA Audio sound system? This Equalizer works
with any audiovideo program where the ALSA Audio
sound system is the system audio provider program.
Only three steps are required.
1) Install
Synaptic.

the

alsapluginequal

package

from

2) Install these configurations into a file called
asound.conf into the /etc directory as the root user.
# /etc/asound.conf file for terminal
command: $alsamixer D equal

[Desktop Entry]
Name=AlsaMixer  EQ
Comment=Advanced Linux Sound Architecture
(ALSA) Equalizer
Exec=sakura e alsamixer D equal
Icon=sound_section
Terminal=false
Type=Application
Categories=Audio;Mixer;XMandrivaLinux
MultimediaSound;

The .desktop file above uses Sakura as the terminal
to display the equalizer in. You should be able to
replace Sakura with your favorite terminal program
(Konsole, Xfce4terminal, Xterm, etc.).
Go to your desktop menu>Sound>AlsaMixer  EQ
and click that menu item.
The Equalizer appears as such :

ctl.equal {
type equal;
}
pcm.plugequal {
type equal;
slave.pcm "plug:dmix";
}
pcm.!default {
type plug;
slave.pcm plugequal;
}

3) Install these configurations into a file called
alsaEQ.desktop into the /usr/share/applications
directory as the root user.
Advertisement
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The Equalizer has 10 bands which affect both stereo
channels equally. The settings are fully adjustable
and take effect at once. Use the arrow keys to
navigate to each frequency and to change the audio
levels up or down for the selected frequency.
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Normalize The Volume
Of Your MP3 Files With MP3Gain

by agmg (Antonis Komis)
Introduction

I’m pretty sure that most of you have faced the
following situation: you have a large collection of
MP3 files from different sources (cd’s, online
purchases etc) but when listening to them, you find
out that they play in different volumes, making
listening to them pretty annoying. Don’t worry, this
can be easily fixed with a nice little program called
MP3Gain.
MP3Gain and how it works
MP3Gain is a program that analyzes MP3 files to
determine how loud they sound to the human ear. It
can then adjust the MP3 files so that they all have
the same loudness without any quality loss. This
way, you don't have to keep reaching for the volume
dial on your MP3 player every time it switches to a
new song.
MP3Gain is an implementation of ReplayGain,
supporting Track mode and Album mode. However,
with most other formats, the necessary loudness
adjustment of ReplayGain is stored as metadata,
thus leaving the encoded results alone. With
MP3Gain, the loudness adjustment is done on the
data itself, albeit in a lossless/reversible way.
Another difference with MP3Gain is the fact that it
can only adjust physical volume in 1.5 dB steps.
Here's the technical reason on why it's lossless
(despite operating on the data itself), and also why
the smallest change possible is 1.5 dB:

The MP3 format stores the sound information in
small chunks called "frames". Each frame represents
a fraction of a second of sound. In each frame there
is a "global gain" field. This field holds an 8bit
integer which can represent values from 0 to 255.
When an MP3 player decodes the sound in the
frame, it uses the global gain field to multiply the
decoded sound samples by 2^(gain/4).
• If you add 1 to this field in all the MP3 frames, you
effectively multiply the amplitude of the whole file by
2^(1/4) = 119 % = +1.5 dB.
• Likewise, if you subtract 1 from this field, you
multiply the amplitude by 2^(1/4) = 84 % = 1.5 dB.
The way MP3Gain works actually has a very strong
benefit. Since it is the data itself that is modified,
MP3Gain does not require special support from
players.
ReplayGain is a proposed standard published by
David Robinson in 2001 to measure the perceived
loudness of audio in computer audio formats, such
as MP3 and Ogg Vorbis. It allows players to
normalize loudness for individual tracks or albums.
This avoids the common problem of having to
manually adjust volume levels between tracks when
playing audio files from albums that have been
mastered at different loudnesses.
ReplayGain is now supported in a large number of
media players and portable media players and
digital audio players. Although the standard is now
formally known as ReplayGain, it was originally
known as Replay Gain and is sometimes
abbreviated RG.

You can find more information about ReplayGain
and how it actually works, from the official website:
http://www.replaygain.org/
Most popular audio players available in Linux, such
as Amarok, Banshee, Clementine, Audacious, VLC,
XBMC and many more, support ReplayGain, either
natively or with the use of plugins. So, you can
enable ReplayGain while listening to your music with
such a player and have all your files play in the
same volume. But if you want to listen your files
using players that do not support ReplayGain, or if
you just want to permanently adjust the audio level
of all your MP3 files, then MP3Gain is the tool for the
job.
MP3Gain can be used either from the terminal, or by
using a nice GUI called EasyMP3Gain, which is
available in the PCLinuxOS repositories. I will
explain both methods so you can choose the one
that suits you better.
Install MP3Gain and prepare your mp3 files
First of all, you need to install MP3Gain and,
optionally, its GUI, EasyMP3Gain.
Open up Synaptic Package Manager, hit “Reload”
and then search for “mp3gain” (next page, top left).
Select the package “mp3gain” for installation. If you
select
“easymp3gain”
for
installation,
then
“mp3gain”, “aacgain” and “vorbisgain” will be marked
for installation, too.
Next, we need a folder containing MP3 files to work
with. Although the changes MP3Gain makes to the
files are reversible, I suggest you work on a test
folder, at least at first. When you have become
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Let’s see what’s inside that folder:
[agmg@localhost Music]$ ls l
total 26944
rwxrwx 1 agmg agmg 9204417
2012 test01.mp3*
rwxrwx 1 agmg agmg 4366398
2012 test02.mp3*
rwxrwx 1 agmg agmg 4842479
2012 test03.mp3*
rwxrwx 1 agmg agmg 9164943
2012 test04.mp3*
[agmg@localhost Music]$
familiar with the use of mp3gain and have tested it
on a couple of your MP3 files, you can then use it on
a larger scale.
I will use the folder “Music,” which is located in my
personal folder (/home/agmg/Music).
In this folder, I have four MP3 files with names
test01.mp3,
test02.mp3,
test03.mp3
and
test04.mp3. I will use those files to demonstrate the
operation of MP3Gain.
Using MP3Gain from the terminal.
Open your favourite terminal emulator and navigate
to the folder where your MP3 files are located. In my
example, it’s /home/agmg/Music.
[agmg@localhost ~]$ cd
/home/agmg/Music
[agmg@localhost Music]$
Or:
[agmg@localhost ~]$ cd ~/Music
[agmg@localhost Music]$
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Running MP3Gain with no options on certain MP3
files will perform an analysis of the files selected.
Let’s see it in action:
Jul 13
Jul 13
Jul 22
Jul 14

The syntax for MP3Gain is: mp3gain [options]
<filename 1> [<filename 2> ...]
You can issue the command mp3gain ? to view a
list of all available options.
We will discuss all options right away, but first, let
me explain the difference between Track Gain and
Album Gain.
Track gain: applies gain to separate tracks (MP3
files) so they all sound equally during playback. The
default volume in mp3gain is 89dB but can be
manually set to higher or lower values, using 1.5dB
steps (as explained earlier). Use this option if you
want all your MP3 files to have the same volume
when played. Best option when creating custom
playlists containing MP3 files from different sources.
Album gain: applies a single gain change to all files,
so their loudness relative to each other remains
unchanged but the average album loudness is
normalized. In album gain analysis, an additional
peakvalue and gainvalue, which will be shared by
the whole album, is calculated.
Use this option if you want your albums to sound
equally loud with different tracks having different
loudness. Best when listening to a whole album
where all files come from the same source.

[agmg@localhost Music]$ mp3gain *.mp3
test01.mp3
Recommended "Track" dB change:
3.175000
Recommended "Track" mp3 gain change:
2
Max PCM sample at current gain:
20603.994112
Max mp3 global gain field: 184
Min mp3 global gain field: 120
test02.mp3
Recommended "Track" dB change:
7.410000
Recommended "Track" mp3 gain change:
5
Max PCM sample at current gain:
40663.547904
Max mp3 global gain field: 255
Min mp3 global gain field: 146
test03.mp3
Recommended "Track" dB change:
2.845000
Recommended "Track" mp3 gain change:
2
Max PCM sample at current gain:
19178.061824
Max mp3 global gain field: 206
Min mp3 global gain field: 108
test04.mp3
Recommended "Track" dB change:
11.685000
Recommended "Track" mp3 gain change:
8
Max PCM sample at current gain:
54804.119552
Max mp3 global gain field: 213
Min mp3 global gain field: 28
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Recommended "Album" dB change for all
files: 10.450000
Recommended "Album" mp3 gain change
for all files: 7

Max mp3 global gain field: 184
Min mp3 global gain field: 120

I have selected MP3Gain to analyze all MP3 files
inside the “Music” folder by using the * wildcard. I got
back the results of this analysis and the proposed
gain for each track and for the whole album.

Recommended "Album" dB change for all
files: 10.450000
Recommended "Album" mp3 gain change
for all files: 7

Recommended "Track" dB change represents the
difference between the track’s volume and the
default volume of MP3Gain in dB (MP3Gain’s default
volume is set at 89dB).
Recommended "Track" mp3 gain change
represents the gain that should be applied to the
track so it reaches the default volume. MP3Gain
applies volume gains in steps of 1.5dB, so a track
gain of 2 would lower the track volume by 3dB.
Recommended "Album" dB change for all files
represents the difference between album’s average
volume and the default album volume set in
MP3Gain (89dB).
Recommended "Album" mp3 gain change for all
files represents the single gain that should be
applied to every track of the same album (same
folder) so that the whole album’s volume is
normalized (according to mp3gain’s default album
volume) while maintaining the volume difference
between tracks.
Let’s see an analysis of the first file:
[agmg@localhost Music]$ mp3gain
test01.mp3
test01.mp3
Recommended "Track" dB change:
3.175000
Recommended "Track" mp3 gain change:
2
Max PCM sample at current gain:
20603.994112
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Issuing the command mp3gain test01.mp3 will
not analyze the file again since it’s already been
analyzed the first time we issued the command (for
all files) and the program has written a tag
containing the results of the analysis. The command
then reads that tag and gives back those results.
The tag is modified every time MP3Gain makes
changes to reflect the previous and the current
status of the file and enables us to reverse those
changes.
If you want to reanalyze the file, you must use the
s
r option. You will see that the program
recalculates the volume of the file. The s option
has many more parameters that are related to tag
handling:
s c
only check stored tag info (no other
processing)
s d
delete stored tag info (no other processing)
s s
skip (ignore) stored tag info (do not read or
write tags)
s r
force recalculation (do not read tag info)
s i

use ID3v2 tag for MP3 gain info

s a

use APE tag for MP3 gain info (default)

Now, let’s have a closer look at the results:
Recommended "Track" dB change is 3.175000.
This means that the actual volume of the track is 89
+ 3.175 = 92.175 dB. So, we must apply a track gain
of 2 (2 x 1.5 dB) if we want the track to go close to
89 dB. The fact that MP3Gain only increases or
decreases the volume in steps of 1.5 dB, suggests

that we can’t have the exact set volume but a very
close value.
Let’s apply the recommended track gain to the file:
[agmg@localhost Music]$ mp3gain r
test01.mp3
test01.mp3
Applying mp3 gain change of 2 to
test01.mp3...
and see the results:
[agmg@localhost Music]$ mp3gain
test01.mp3
test01.mp3
Recommended "Track" dB change:
0.170000
Recommended "Track" mp3 gain change: 0
Max PCM sample at current gain:
14569.242624
Max mp3 global gain field: 182
Min mp3 global gain field: 118

Recommended "Album" dB change for all
files: 0.170000
Recommended "Album" mp3 gain change
for all files: 0
In the next example, I will increase the volume of my
file to a value higher than the default 89 dB, lets say
to 95 dB. The difference is 6 dB:
[agmg@localhost Music]$ mp3gain d 6
r test01.mp3
test01.mp3
Applying mp3 gain change of 4 to
test01.mp3...
MP3Gain applied a gain of 4 to increase the volume
of the file by 6 dB. The d switch modifies
suggested dB gain by floatingpoint set afterwards.
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There is one more switch which modifies the
suggested mp3 gain. The switch is m followed by
an integer number.
So:
m <i> modify suggested mp3 gain by integer i
d <n> modify suggested dB gain by floatingpoint n
Let’s use another file in the next example:
[agmg@localhost Music]$ mp3gain
test02.mp3
test02.mp3
Recommended "Track" dB change:
7.410000
Recommended "Track" mp3 gain change:
5
Max PCM sample at current gain:
40663.547904
Max mp3 global gain field: 255
Min mp3 global gain field: 146

Recommended "Album" dB change for all
files: 10.450000
Recommended "Album" mp3 gain change
for all files: 7
The suggested mp3 gain for this file is 5.
Again, this means a volume decrease of 5 x 1.5 db=
 7.5 dB.
If I use the m switch, I can alter the recommended
mp3 gain for this file and apply it:
[agmg@localhost Music]$ mp3gain m 2
r test02.mp3
test02.mp3
Applying mp3 gain change of 3 to
test02.mp3...
Now I want to show you something else. Let’s use
another file:
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[agmg@localhost Music]$ mp3gain
test03.mp3
test03.mp3
Recommended "Track" dB change:
2.845000
Recommended "Track" mp3 gain change:
2
Max PCM sample at current gain:
19178.061824
Max mp3 global gain field: 206
Min mp3 global gain field: 108

Recommended "Album" dB change for all
files: 10.450000
Recommended "Album" mp3 gain change
for all files: 7
So, the volume of this file is 89 + 2.845 = 91.845dB
I will try to increase the volume of the file by a large
amount, lets say 12 dB.
The file’s volume is already around 3dB higher than
the default.
So the gain that the program will apply is: 12 ÷ 1.5 2
= 6.
Let’s see:
[agmg@localhost Music]$ mp3gain d 12
r test03.mp3
test03.mp3

WARNING: test03.mp3 may clip with mp3
gain change 6
Make change? [y/n]:
What’s this warning? What is clipping?
In a real world situation, if you push a speaker
beyond its capabilities, then the audio from it will be
clipped  this is sometimes referred to as
overloading. This happens because there is a limit to
the amount of power supplying the amplifier inside
the speaker  if the requirements go beyond this
then the amplifier will clip the input signal. In this

circumstance, instead of a smooth sine wave being
produced for normal audio, a square waveform
(clipped) will be outputted by the amplifier resulting
in sound distortion.

Similarly in digital audio, there is also a limit on how
far an input sound can be represented. If the
amplitude of a signal goes beyond a digital system's
limits then the rest of it will be discarded. This is
particularly bad in digital audio as a large amount of
definition can be lost through audio clipping.
So how can we handle clipping? We have two
options:
c

ignore clipping warning when applying gain

k
automatically lower Track/Album gain to not
clip audio
Let’s reissue the command using the k switch:
[agmg@localhost Music]$ mp3gain d 12
r k test03.mp3
test03.mp3
Applying autoclipped mp3 gain change
of 3 to test03.mp3
(Original suggested gain was 6)
Applying mp3 gain change of 3 to
test03.mp3...
The program lowered the track gain by 3 so that the
audio will not be clipped.
Same options discussed so far, apply also when
using the program in Album gain mode.
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Let’s see some examples:
[agmg@localhost Music]$ mp3gain
test02.mp3 test03.mp3
test02.mp3
Recommended "Track" dB change:
2.890000
Recommended "Track" mp3 gain change:
2
Max PCM sample at current gain:
24178.698469
Max mp3 global gain field: 252
Min mp3 global gain field: 143
test03.mp3
Recommended "Track" dB change:
7.360000
Recommended "Track" mp3 gain change:
5
Max PCM sample at current gain:
32253.529587
Max mp3 global gain field: 209
Min mp3 global gain field: 111

Recommended "Album" dB change for all
files: 6.100000
Recommended "Album" mp3 gain change
for all files: 4
Let’s apply the recommended Album gain using the
a switch:
[agmg@localhost Music]$ mp3gain a
test02.mp3 test03.mp3
test02.mp3
test03.mp3
Applying mp3 gain change of 4 to
test02.mp3...
Applying mp3 gain change of 4 to
test03.mp3...
Of course, we can modify the mp3 or dB gain, like
we did in Track gain mode:
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[agmg@localhost Music]$ mp3gain d 2
a test02.mp3 test03.mp3
test02.mp3
test03.mp3
Applying mp3 gain change of 1 to
test02.mp3...
Applying mp3 gain change of 1 to
test03.mp3...
[agmg@localhost Music]$ mp3gain m 4
a test02.mp3 test03.mp3
test02.mp3
test03.mp3
Applying mp3 gain change of 5 to
test02.mp3...
Applying mp3 gain change of 5 to
test03.mp3...
There are a few more switches that can be used
with the command line version of MP3gain, although
we have covered the most important ones. You can
view a full list of all MP3Gain options by issuing the
command mp3gain ?
I will also list here those not covered extensively for
your convenience:
v

show version number

g <i>
analysis

apply gain i without doing any

t
writes modified data to temp file,
then deletes original instead of modifying bytes in
original file
q

Quiet mode: no status messages

p

Preserve original file timestamp

x

Only find max. amplitude of file

f
Assume input file is an MPEG 2
Layer III file (i.e. don't check for misnamed Layer I
or Layer II files)
? or h show help
u
undo changes made (based on
stored tag info)
w
"wrap" gain change if gain+change
> 255 or gain+change < 0 (use "? wrap" switch for a
complete explanation)
Using MP3Gain from the GUI (EasyMP3Gain).
Let’s begin with a presentation of the GUI and a
short explanation of the program’s options.
This is the main EasyMP3Gain window:

l 0 <i> apply gain i to channel 0 (left channel)
without doing any analysis (ONLY works for
STEREO files, not Joint Stereo)
l 1 <i> apply gain i to channel 1 (right channel)
e
files listed

skip Album analysis, even if multiple

o
delimited list

output is a databasefriendly tab
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Let’s add some files in our list:

volume level. Click the Album Analysis button to
begin this process.

Add file(s) or File > Add Files to add single
file(s).
Add folder(s) or File > Add Folder to add a
whole folder.
I have added my /home/agmg/Music
containing a new set of mp3 files:

folder,

These files have no gain information on them so,
first thing we should do is scan them.
This button has two options: Track Analysis
and Album Analysis (default).
Track Analysis: If you have queued up a selection
of unrelated MP3 songs that are not part of a
complete album then you can simply click on the
Track Analysis button. Doing this will examine each
MP3 file in the list and calculate the replay gain
value based on the target volume setting (default is
89 dB).
Album Analysis: If you're working on an album then
click on the down arrow button next to the Track
Analysis icon and select the Album Analysis mode.
This is a better option in this scenario because all
the files will be normalized based on the total album
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Let’s see the differences between Track Analysis
(first screenshot) and Album Analysis (second
screenshot) on these MP3 files:

In the second case, I applied Album Gain after
performing an Album Analysis. The result is that all
tracks of the Album have the same average volume,
while maintaining the relative difference between
them.
Let’s have a look at the next button:
Similar to the previous button, this one
also has two options: Apply Track Gain
and Apply Album Gain.
Once again, let’s see the differences. First
screenshot shows the same MP3 files after applying
Track Gain and the second, after applying Album
Gain (top, right).
In the first case, I applied Track Gain after
performing a Track Analysis on my MP3 files. The
result is that all files now have the same volume
(89dB).

Let’s move on to the next buttons:
This button removes the selected file(s)
from the list.
This button removes all files from the list.
This button instructs the program to
process only the selected file(s).
Here you can
change the
default volume.
This buttons stops current operations (will
turn red when program is busy).
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Now, let’s go through EasyMP3Gain’s menus and
have a look at the additional options:

Let’s have a look under the Advanced options:

The option Number of sublevels when adding
files alters the behaviour of the Add folders
recursively command. It specifies the number of
folders underneath the initial one that MP3Gain will
look into when adding files.

Add folder recursively will
add a folder and the file it
contains,
including
all
subfolders.

As you can see from the above window,
EasyMP3Gain also supports aac and oggvorbis
files through the commandline backends aacgain
and vorbisgain (which are also installed
automatically when installing EasyMP3Gain). If you
want to view the options of those two backends, you
can issue the following commands in terminal:

Selecting Clear will remove all
analysis results from the list.

aacgain help (for aacgain options)
vorbisgain ? (for vorbisgain options  exactly the
same as MP3Gain)

Apply constant gain will
apply a fixed gain to all files,
regardless their volumes.
Undo instructs the program to
undo all changes previously
made.
Read
Tags
tells
the
program to read the tags
written during a previous
analysis.
Delete Tags removes all
tags written by MP3Gain.
Selected files only will apply changes only to the
files you have selected.
Show console output will open up a new window
showing console messages generated by the
mp3gain backend.
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Preserve original timestamp: check this option if
you want the original file timestamp to be untouched.

Conclusion

Ignore Tags tells MP3gain to not read or write any
tags on the file.
Note: If you choose the “Ignore Tags” option, then
you will not be able to automatically undo changes
made by MP3Gain. You will still be able to undo any
changes, but you will have to manually keep track of
what changes you make to your files.
Autoread tags when adding files or directories:
if this options is unchecked, you have to hit the
Analyze button to display gain information stored in
tags during a previous analysis.
Use temporary files will instruct MP3Gain to write
modified data to temp file, then delete original
instead of modifying bytes in original file.

While using MP3Gain with a GUI is a lot more
easier, there may be times when the commandline
version is more useful. You could create a bash
script that will automatically search and apply the
options you specify to several of your MP3 files or
albums without needing your attention.
An example using the find command:
find /home/agmg/Music iname "*.mp3"
exec mp3gain d 4 r {} +;
This command will search for every MP3 file inside
the /home/agmg/Music directory and will apply a
track gain (r switch) by modifying the default volume
by 4dB.
You can find more information about MP3Gain on
the official website, at:
http://mp3gain.sourceforge.net/.
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GIMP Tutorial: Exploring the Create Menu
by Meemaw
I’ve been using Gimp for quite a while, and haD
never noticed a section in the File menu. It says
‘Create’ and in it are several alreadyconfigured
items that you can make in just a few minutes.

Now, let’s do a button. Click on File > Create >
Button.

There aren’t as many choices. Let’s do a simple
beveled button. The only way to increase the size of
your button is to change the font size. The ones
below are 63 pixels wide and 24 pixels tall with the
font size 15.

Let’s play a little. After opening Gimp, click on File >
Create > Logos. You will see many options.
This window contains all the configuration items you
need. You can change the text, font and size, along
with the gradient you want to use for the text (Deep
Sea or Caribbean Blues) and outline (Brushed
Aluminum) plus the color for the background (Dark
Blue). You can experiment with many of the settings,
including using patterns for the text or outline, or
even overlaying the whole thing with a pattern. Make
as many as you want and save the ones you really
like.

Let’s do a Glossy logo. Choose Glossy from the list
and you will see this window (center, top):
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I changed the upper left to purple and the lower right
to dark blue (my colors of preference). After I made
one, I changed the text color to white. Then I made a
third and clicked the “Pressed” check box. This one
looks like a button after I have clicked on it.
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As always, experiment with colors and settings to
get just what you want.
Another section in the create menu is Create >
Pattern.

As you can see, there are 3 colors to set. The
‘Smooth’ checkbox puts a blur into your camouflage
and the ‘Flatten’ checkbox merges all the layers
together.
The Create menu has many different items you can
try. Another couple of patterns are below:

Two other items are at the top of this menu. The first,
Create from Clipboard, places clipboard contents
directly into Gimp so you can work on it. The second
is Create from Screenshot. Choosing it gives you
the following window:

Swirly Tile

I chose Camouflage

3D Truchet

You can also design items for web pages, including
arrows, bullets, buttons, headings and Hrules
(horizontal rule, which can be used as a border or
divider) in two different patterns:

Image size is how many pixels on each side, so with
400, it will be a 400 x 400 square. Granularity is how
much detail to camo has. In the image below, the left
side’s sample has granularity of 2, and the right
side’s is 15.

You can configure your screenshot method (window,
screen or region) and any delay you want, click
Snap, then the screenshot is imported into Gimp for
you to manipulate.
We’ve had some fun with the Create menu. Its
readymade configurations are nice if you need to
design something quickly, like a button or a pattern.

Visit Us On IRC

Arrows for the two patterns are shown below on the
tabs in Gimp. The design on the left is called Alien
Glow, and the one on the right is called Beveled
Pattern.

• Launch your favorite IRC Chat Client software
(xchat, pidgin, kopete, etc.)
• Go to freenode.net
• Type "/join #pclosmag"
(without the quotes)
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Visit.
Contribute.
Build.
The
PCLinuxOS
Knowledge
Base

It Belongs To YOU!

Want to keep up on the latest that's
going on with PCLinuxOS?
Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos

Screenshot
Screenshot Showcase
Showcase

Support PCLinuxOS! Get Your Official

PCLinuxOS

Merchandise Today!

Posted by ferry_th, March 7, 2013, running Openbox.
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PCLinuxOS Recipe Corner

Bacon and Egg Lasagna
Ingredients:
12 lasagna noodles (cooked and drained)
2 Tbsp. chopped parsley
1 lb. bacon (cut in 1 inch strips)
1/4 tsp. pepper
1 cup chopped onion
4 cups milk
1/3 cup bacon drippings
12 hard cooked eggs (sliced)
1/3 cup all purpose flour
2 cups shredded Swiss cheese
1/2 tsp. salt
1/3 cup grated Parmesan cheese
Cooking Instructions:
1. In large skillet, cook bacon until crisp; drain,
reserving 1/3 cup drippings. Set bacon aside. Cook
onions in bacon drippings until tender. Add flour, salt,
and pepper. Stir until a paste forms.
2. Add milk; cook and stir until mixture comes to a
boil and is thickened.
3. Heat oven to 350 degrees F. Grease 9x13 inch
baking dish. Spoon a small amount of white sauce
into bottom of pan. Divide lasagne noodles, bacon,
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white sauce, eggs, and Swiss cheese into thirds;
layer in pan. Sprinkle with Parmesan cheese. Bake
at 350 degrees for 2530 minutes or until thoroughly
heated. Sprinkle with parsley. Let stand 10 minutes
before serving. Makes 12 servings. Can be made
the day before.

Does your computer run slow?
Are you tired of all the "Blue Screens
of Death" computer crashes?

Are viruses,
adware, malware &
spyware slowing
you down?
Get your PC back
to good health
TODAY!
Get

Download your copy today! FREE!
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PCLinuxOS Saves The Day!
by alex25502

Then I remembered I had brought my PCLinuxOS
based (LXDE 2012.01) netbook to the church. I
figured why not.
After boot up, I inserted their stick.
Moments later, PCLinuxOS acknowledge
the stick! I copied the music to another
stick, and immediately returned the other
stick to its rightful owner. I explained my
situation to him, then he told me that the
stick had been formatted on an Apple!
Obviously, Microsoft doesn't like Apple.
Had it not been for my netbook in my
backpack, their part of the rehearsal
would not have happened. A wasted trip
of 40 miles (64.4 Km) – oneway – was
avoided thanks to PCLinuxOS!

Reach Us On The Web
PCLinuxOS Magazine Mailing List:
http://groups.google.com/group/pclinuxosmagazine
PCLinuxOS Magazine Web Site:
http://pclosmag.com/
PCLinuxOS Magazine Forums:
http://www.pclinuxos.com/forum/index.php?board=34.0

On a parttime basis, I operate a professional sound
system at the church I attend. Recently, I was
working on a project with a performing arts group
that was to perform at the church.
A small team of performers from out of town was to
join our local group for the big event. Upon their
arrival, one of them handed me a USB stick, which
contained their music. Also given to me was a list of
their skits and the names of the songs in
chronological order.
Our multimedia booth has two Microsoftbased
computers. Once I arrived in the booth, I fired up
one of the towers. After inserting the stick, I waited
for the tower to acknowledge the drive. Ain't
happening! So I inserted one of my sticks in a
nearby port. Mine was acknowledged. So I decided
to repeat the process on the other tower. Same
results.
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Full Monty ...

Everything you might want or need –
plus the kitchen sink!
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Get Off The Proprietary Merry Go Round
by Kevin Keijzer
Shared via Google+
Reprinted with permission
In my opinion, individual freedom is one of the most
important things in life. The entire point of a capitalist
society is that it revolves around the individuals.
Whichever company can comply to the consumers'
wishes the most, will be the most successful one.
Most people will think of this as very reasonable.
You'll only spend money on something of which you
believe it will be of good use to you.
When we follow this analogy, one could say that
apparently 90% of the computer users find that
Microsoft Windows is the best computer operating
system out there. But that's where the cookie starts
to crumble, because I don't believe that anyone has
ever gone to a store to buy a new PC or laptop with
Windows®. People just want a new computer, which
always happens to have Microsoft Windows pre
installed. Very few consumers are even aware that
(better) alternatives are available. Some might
perhaps know that Apple uses "something different",
but in most cases, that's as far as their knowledge
goes.
Microsoft's entire Windows ecosystem is based
upon tying their products to others and abusing the
ignorance of average consumers. This is also why
so many average people know so little about
computers, even though they've been around for
years now. Microsoft has designed their Windows
operating system in such a way that it offers many
ambiguities, and that the user will never be quite
certain about what exactly happens on their
machine. Microsoft's primary reason for doing so, is
that there are many "repairmen" out there who would
love to make some money off Microsoft's empire as
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well, after which they can become "most valuable
professionals," "certified platinum partners," or other
complete and utter nonsense. I can guarantee that
many of those "repairmen" charge way too much
money for their "repairs." But hey, when all a

computer shows is a blue screen with an
indecipherable error code, most consumers will just
take their machine back to”'the store.” Can you
blame them?
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Moreover, Microsoft wants to keep their internal
systems secret, because offering too much
transparency would soon let people find out about
everything that is really happening within the
Windows operating system. It's a commonly known
fact that many backdoors are built in to enable
governments to monitor the activities of users, and
there are most likely many other hatches of which
nobody knows or may know the presence.
The fact that governments, schools, hospitals, police
stations, the military, and nonprofit organizations all
make use of Microsoft products on such a massive
scale without considering the dangers, is something
I find unimaginable. Whatever commercial
companies want to do is their own business, but the
fact that those public institutions are willing to do
business with a company like Microsoft, is
inexcusable to me. Microsoft Windows and
proprietary software in general doesn't show a single
sign of respect for the freedom and rights of its
users. While everyone loves to talk about the
importance of things like freedom of speech, barely
anyone seems to care about the enormous influence
that companies like Microsoft and Apple have on the
devices we use the most. Nearly everybody spends
hours behind their computer every day, and
gratefully uses all the possibilities, but no one even
seems to think about the history of the device loved
by so many.
Throughout the years, there have been many
situations in which Microsoft and Apple have abused
their large amounts of money in order to push
competitors from the market, by the simple means of
bribery. Because especially Microsoft's products are
completely based upon oppressive licensing
systems, it is rather easy for them to force hardware
vendors to make certain decisions, especially since
the time that Microsoft Windows had gained such a
market position that it had sadly become a selling
point.
Around 1999, Bill Gates personally sent an email to
other Microsoft employees, in which he stated that
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they should try to do whatever they could to stop
GNU/Linux from working on regular PC's, even if it
meant they'd have to force OEM's to do as they said,
damage open standards, or patent trivial things. This
behavior combined with the fact that due to
Microsoft's efforts of keeping people as ignorant as
possible about the fact that they even had a choice,
rapidly ensured that all the hardware vendors did
exactly as commanded by "big boss" Microsoft. Just
search the web for the Comes v. Microsoft case if
you want to know more about this specific chapter of
Microsoft's long and ongoing history of being evil.
Luckily for us, Microsoft is not very good at writing
decent software, so the consequences aren't as bad
as they had probably hoped. Then again, what we
do see is that virtually every hardware vendor
exclusively supports Microsoft Windows nowadays.
If GNU/Linux users point out that they have a
problem with a certain piece of hardware, the
vendor's response nearly always is that the users
are advised to install Microsoft Windows, because
they do not want (or are allowed) to support other
operating systems. Even the BIOS, the first piece of
firmware that initializes the hardware and
bootloader, is usually filled with intentional errors of
which only Microsoft developers are told how to
avoid them. Because of this, it generally takes Linux
kernel developers weeks or even months before
they have reached the same results, by which the
average user comes to believe that "GNU/Linux is
less decent than Microsoft Windows."

Windows operating systems (nearly) impossible,
under the guise of "security."
Apple has been fighting a comparable battle,
although not so much on the desktop, because they
aren't quite successful there themselves either, and
GNU/Linux isn't a direct threat to their iMacs and
MacBooks as much as it is to Microsoft Windows.
However, a different incarnation of GNU/Linux,
Android, is. Whereas Microsoft tries to do whatever
they can to "break" GNU/Linux on the desktop,
Apple has been filing patent lawsuits about the most
trivial things for years now, hoping as many Android
devices as possible will be banned from the store
shelves. Not very long ago, the Android flagship
device of the time, the Samsung Galaxy Nexus, was
banned in the USA for a few days, because Apple
found one tiny piece of Android to be similar to
something their iPhone could also do. Even though
the offending feature was removed and changed
within a few days, Apple has never given up on the
battle, and it doesn't look like they ever will.
Everywhere in the world, lawsuits are filed against
vendors of Android phones and tablets, hoping they
can get those products banned as well.

For instance, recently a (probably intentional) BIOS
bug showed up in many new laptops, causing the
battery life of machines running GNU/Linux to be
noticeably shorter than the same machines running
Microsoft Windows. This was merely because the
vendors refused to implement the offending feature
in a transparent way, and let only Microsoft know
how it worked. And now, under pressure of the
Redmondbased company and its "BFF" Intel, a
system to replace the BIOS altogether, called UEFI,
has been pushed into consumer motherboards,
while having builtin features to make booting none
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Aside from intentionally ruining fair competition on a
hardwarelevel, Microsoft and Apple also use large
parts of their money to make doubtful deals with
many different companies, primarily to harm their
competitors. A few years ago, Microsoft developed a
media player named Silverlight, a completely
useless product which they eventually even admitted
themselves that it had very little right of existence.
Regardless, Microsoft has lobbied quite a long time
to make many content providers switch to their
poorly received proprietary product, which is
essentially an even worse clone of Adobe Flash.
They even gave up a board seat to the CEO of the
popular video streaming site Netflix if he would get
his company to support Silverlight exclusively. And
he did.

Microsoft and Apple do not care the least about their
users. The only thing in which they're interested, is
making money off them. And if that hurts the users'
privacy, so be it. If that hurts the users' security, so
be it. If that hurts the users' convenience, so be it. If
that hurts the living conditions of Chinese
employees, usually only twelve years old, so be it.
Why would anyone trust companies like that?

Painfully, I have to watch how people have been
improperly informed for years, over and over again.
The things that many people say out loud about
computers, of which they really believe that they are
true, are generally just completely incorrect.
Primarily, the elderly users suffer from that. They
didn't grow up with computers, so they obviously
know less about them. But when they ask for help,
barely anyone is able to really explain them
anything. Pretty much every "computer expert" is
part of the same enormous group of (generally
extremely arrogant) people who grew up during the
Microsoft monopoly, and really don't have a clue
what they're doing either, because it's Microsoft's
primary goal to let its users know as little as
possible.

Apple does not have such a strong case with their
software, but they are capable of shoving their
gadgets down everyone's throat. For example, I read
about a high school in Belgium a while ago, where
all students were forced to buy an iPad, because
Apple would sponsor them. Even though many
students and parents refused and protested, the
plan was executed nonetheless, after which many
students left the school. Also, many people have
probably noticed that a lot of American films and tv
shows only feature Apple computers, to make
people believe that Apple products are some kind of
symbol of wealth.
What many people don't seem to understand, is that
buying a product made by Microsoft or Apple, does
not make them the owner, regardless of the fact that
they went to the store and paid money for it. Even
worse: nearly everyone just agrees to very
constrictive license terms, usually without even
reading them. For instance, everyone who owns an
iPhone or iPad apparently has no problems with
their location data being logged and sent to Apple,
and every company using Microsoft Windows seems
to be fine with random checks whether the software
they use is legitimate. And I'm not talking about a
software tool doing so, but a physical guy coming
along for a visit.
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ever going to change. There simply are too many
limitations to the ARM architecture to ever be a
complete replacement for the current generation of
x86 machines. MIPS would have had a bigger
chance if it had undergone more active, widescale
development over the last years, which our "friends"
at Redmond HQ obviously didn't want to happen.
That's why I've always been much more interested in
the future of GNU/Linux on the desktop than what
exactly happens to Android, which lacks the pieces
of software I love the most anyway: GNU.

I have always tried to remain neutral regarding the
whole iOS versus Android discussion, for one,
because I don't believe that tablets and smartphones
are that great, but primarily because I believe it
takes the attention away from something much more
important: Microsoft Windows versus GNU/Linux on
the desktop. After all, it’s still the computers and
laptops that do the most real work. Regardless of
how some may feel about it, I do not believe this is

I'm sure this isn't very different compared to other
industries, where consumers are also being
scammed on a daily basis. Surely, employees of car
garages or central heating installers will supply false
information to keep customers ignorant just as
much. But computers are different because
everyone acts like this. It's not just the
"professionals," but also the users among each
other. Friends and relatives brag about things that
work completely different than they think they do, for
instance. After being in such situations for many
years now, I've come to the point where I simply
cannot stand it any longer. For some reason,
everyone seems to think it is somehow "shameful" to
admit you don't know so much about a certain
subject. Everyone always wants to come across as
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some kind of genius, and barely anyone is willing to
listen anymore. Because when you listen to
someone else, you admit you don't know it yourself.
Or something like that, I guess.
There are so many people who swear at their
computer every day, and really have no to little clue
on how to operate it, but as soon as you tell them
there are alternatives out there that can be far less
problematic, most people refuse to try it because it
would mean they can no longer boast about the few
things they do know about Microsoft Windows, or
because they would have to ask for help every now
and then in the beginning. It also feels like the
generally accepted description of someone who
"knows a lot about computers" is someone who is
good at making spreadsheets in Microsoft Excel, but
as soon as the side of the case has to be removed,
they are nowhere to be found.
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There simply are many valid reasons to prefer free
software over the established empires of Microsoft
and Apple, much more than I can ever describe,
while even leaving the technical side completely out
of the scope. Surely, it is true that GNU/Linux is
much faster and more stable and secure than Apple
Mac OS and especially Microsoft Windows are, and
the fact that it can be used completely free of charge
is something that many people find the most
appealing part, but to me, frankly, those factors
aren't that important.

Microsoft is acting like a tyrant who wants to put
himself on every single person's "personal"
computer, all over the world, and attempts to destroy
everyone who tries to get in his way. Apple, on the
other hand, acts like an unhinged watchdog,
attempting to sue everyone who tries to develop
something square with rounded corners.

GNU/Linux fully respects the user's freedom. Users
running it have full control of their computers, rather
than the other way around. Whenever Microsoft
feels like pushing an update that removes your
ability to do something, noone is stopping them.
Even if you have paid for a valid license and the
function used to be there, they are always in charge
of what happens. When Apple doesn't want a certain
application to run on their devices, they'll simply
remove it from their application store without any
further notice. For instance, they do not allow you to
use an alternative browser engine on their iDevices,
even though their own implementation of WebKit is
very slow. They really don't care at all that you have
paid 800 dollars for your new iPhone, and would like
to decide for yourself. They are vigilant about
remaining in charge. Your wishes are completely
irrelevant. You will pay up and keep quiet, because
you are nothing to them.

If you even care the slightest about computer
technology in general, it is really important to know
that regardless of the fact that these two companies
may be the best known, they have absolutely not
had the biggest and best influence at all. If it was up
to Microsoft and Apple, people will only be able to do
less with their own devices, and they will never be
allowed to decide for what purpose they want to use
their machines, whereas GNU/Linux developers
couldn't care less what you do with your own
property. They make their software hoping that
someone may find it useful. In fact, it's usually even
explicitly stated in the description. It's exactly
because of that kind of transparency that so many
developments have been able to occur in the last
two decades. The entire internet is based upon the
idea of software freedom, which is also why it
primarily runs on GNU/Linux servers. Within the
GNU/Linux community, there is no oppressing
ambiance at all. Developers really don't mind what
people do with their computers, as long as they don't
use them to harm others in any way, which includes
taking away their freedom.

This is the harmful aspect I so desperately want to
clarify. Of course the technical sides of GNU/Linux
are amazing, and I'm convinced that everyone who
gives it a real chance will agree that it offers a much
better computing experience than Microsoft
Windows on the long term. But even if it wouldn't be
better, you would still be doing the ethically right
thing by not spending money on companies that do
not have any respect for you and those around you.
The sooner more people will choose free software,
the quicker the assets of Microsoft will shrink, and
perhaps they might just start making serious efforts
to develop decent products one day. But now,

So please, forget everything they told you about
Microsoft and Apple throughout the years. Just
because they've been very successful economically,
doesn't mean that their intentions are good in any
way. Using their products is harmful for the future of
computer technology in many ways. But more
importantly, it hurts your own freedom, your family's
safety, and human rights. If you want a smartphone
or tablet, don't get an iPhone, an iPad or a Microsoft
Surface, but buy one of the dozens of Android
devices, in particular Google's Nexus phones and
tablets. Also, try to avoid buying computers and
laptops with proprietary software preinstalled. Buy
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computers by the year 2100, rather than having the
computers being in charge of us.
Supporting and endorsing proprietary software is
one of the biggest mistakes anyone can make.
Please, whoever you are, whatever you do, do not
fall for it. But my biggest question remains this:
where the hell is Google in all of this? Google is
using the Linux kernel for basically everything they
do, most obviously Android phones and tablets,

Chrome OS netbooks, and Google TV. They use
modified Ubuntu installations for their entire
company infrastructure, but they never mention
desktop GNU/Linux anywhere. If there's one
company that should do something back to the
community, after everything it has done for them, it's
Google. We need their endorsement, we need their
support (or at least of some really rich company).
Let's face it, they really owe it to us.

Screenshot
Screenshot Showcase
Showcase

barebone laptops and build your computers yourself,
or have someone else build them for you. Of course,
stay away from iMacs and MacBooks as far as you
can.
Not until GNU/Linux has created a serious user base
on the desktop market, will companies understand
that they can't ignore free software any longer. Only
then hardware vendors will stop claiming they only
support Microsoft products. Only then internet
service providers will stop claiming they do not want
to help customers who do not run Microsoft
Windows. Only then will things like Silverlight will no
longer be adopted, because companies will know
that a large part of their user base will either not be
able to run it, or just reject it nonetheless.
It worked for Android and Chrome (and yes, I know
that only AOSP and Chromium are real free
software), but that was only the first step. Switching
your browser isn't enough. Using a mostly free
mobile operating system isn't enough. The most
important thing at this point is that as many people
as possible will switch to GNU/Linux on their desktop
computers and laptops. It would not only improve
their user experience and rejuvenate otherwise
discarded machines, but it will most importantly
ensure that these people contribute to making a
better future, so people will still be in charge of their
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Posted by Crow, March 6, 2013, running LXDE.
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Game Zone: iBomber Attack
by daiashi

• iBOMBER LIVES
• Dripping with the quality gameplay, visuals and
sounds that made the original iBomber games so
loved, iBomber Attacks ensures the legend lives
on!
Key Features:

About The Game
The legendary iBomber series returns but this time
it’s time to ATTACK! Jump into your tank and get
ready to blast your way around Europe and defeat
the enemy in this visceral tour of destruction! With
24 missions full of explosive action to go at, iBomber
Attack is a dose of highoctane entertainment that
you won’t be able to put down.
• TOUR OF DESTRUCTION
• From destroying Navel dockyards, airfields and
secret bases to gunning down legions of flame
throwing soldiers, this is 24 levels of nonstop, high
caliber, action.
• AWESOME FIREPOWER
• Earn ‘Victory Points’ and collect gold to powerup
your tank with Bombs, Bunker Busters, MiniGuns,
Flame Throwers, Rockets, Airstrike's, Supply Drops
& Super Boost's.
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• Tanktastic action
• Super smooth gameplay
• 24 action packed missions
• Amazingly detailed graphics
• Collect Gold to buy PowerUps
• Win Victory Points for upgrades
• Huge levels to explore and destroy
• The satisfaction of blowing everything up!
System requirements
Software: Wine and steam.
Hardware:
Minimum:
• OS: Windows XP
• Processor: 1.5Ghz
• Memory: 512 MB RAM
• Graphics: OpenGL 2.0 Compatible. ATI, NVIDIA
or Intel HD.
• Hard Drive: 900 MB HD space
• Sound: Windows compatible sound card.
• Additional: Older Intel graphics cards may have
slowdown issues.

Recommended:
• OS: Windows 7
• Processor: 2.0
• Memory: 1024 MB RAM
• Graphics: OpenGL 2.0 Compatible. ATI, NVIDIA
or Intel HD.
• Hard Drive: 900 MB HD space
• Sound: Windows compatible sound card.
• Additional: Older Intel graphics cards may have
slowdown issues.
About The Company
How does an indie developer survive for eight years,
get multiple BAFTA nominations and continue to
create great game after great game?
Cobra Mobile was founded in 2005. The word
“mobile” in the company name gives it away. We
were making mobile games. The original tag line for
the business was “Mobile is More,” as we believed in
2005 that with the right content mobile gaming could
be more than it currently was.
In 2005 that meant J2ME (but also BREW and
Symbian). First off we spent six months creating our
basic level of internal tools and tech, which enabled
us to try and test game concepts. This was back in
the day of chunky and clunky mobile phones
(Google for Nokia 3510 or Sony K630 to glimpse the
past). In early 2006, with a few cool game
prototypes, we started speaking to mobile
publishers.
Now, back in 2006, if you wanted to sell a game you
had to sell into a publisher who then, in turn, would
sell it to a carrier who would then, maybe, publish it
and give it a bit of shelf space on the carriers’ mobile
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deck; a clunky and very basic version of what we all
know today as an app store.

All design work at Cobra begins with paper and a pencil
The feedback on our titles was positive, but noone
wanted to sign them as they didn’t have a big brand
name behind them. Again, back in 2006, everything
was about brand names. Luckily for Cobra one of
our games got noticed and we were asked if we
could rebrand it as a Lego game. Lego Bricks on
mobile was born. Another company liked our game
but wanted to rebrand it with their own franchise,
and Sensible Soccer Skillz was born. We were off.
Through to the end of 2007 our mobile work was
great. It was 90% work for hire, and we were
working with major brands and making great games.
As 2008 started the mobile landscape was slipping,
our business had pretty much hit a plateau and
porting was now the new mobile scene. Basically,
mobile devices came in all shapes and sizes and
languages, and any game needed hundreds, if not
thousands, of build versions to cover worldwide
carrier network demands. Companies had a few
people working on games and hundreds working on
porting. Porting could and would sap the will to live
from you. This wasn’t the “Mobile is More” future
we’d dreamed of.
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Luckily for Cobra a massive tectonic shift happened
in 2008; Apple announced it was opening up an App
Store for the iPhone and anyone could submit
content. Apps didn’t even have to be games! This
may appear second nature now, but in 2008 this was
revolutionary. This broke all the rules, along with the
huge monopolies that companies and carriers had
built. I would easily say 95% of companies we spoke
to in 2008 thought Apple was a blip, and didn’t think
it would really offer any competition. I mean, the
iPhone was just another smartphone, and Nokia
already had these, right?

Some Gameplay Screenshots

So when the Apple App Store launched, Cobra had
a launch title: the fantastic Numba. We originally
launched this with a publisher but after they reneged
on the contract we pulled it and published ourselves.
But what we saw from the early success of Numba
was that the new business paradigm of the App
Store would work, and we could directly be involved
in taking our product to market instead of being
porting monkeys and marketing bystanders.
The decision was huge, but pretty easy. We quickly
pivoted and ramped down all J2ME mobile work,
moving fully into iOS development. Scary move, yes.
Few sleepless nights, yes. Right decision by a long
shot? Yes. I remember at the time everyone trying to
tell us we were crazy; we were daft, but anyway you
looked at it, it just made complete sense.
After the awesome Numba, we developed Mouse
About, which arrived to rave reviews but average
sales. We also released a few novelty apps (Anthem
USA and Anthem UK) to help market Numba and
Mouse About to a wider audience. We needed
marketing, but we’re an indie studio trying to make it
in the new app economy.
Answers to Mark Szorady's Double Take:

(1) Shirt stripes different; (2) Hair shorter in back; (3)
Glasses stem missing; (4) “Rock” changed to “rule”;
(5) Bowtie missing; (6) Antenna different; (7) Tongue
moved
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After steam is installed search for iBomber Attack
from the steam store front.

International Community
PCLinuxOS Sites

Netherlands

Getting It To Run
Ok, first things first. Head on over and grab Steam.
WINE should install it with no problems. You will
need Winetricks from synaptic to get some needed
files for steam to run properly. These are corefonts
and vcrun6,both from winetricks.

After downloading IBomber Attack, I had to make no
other changes to get this game running.

Turkey
Denmark

Czechoslovakia

Italy

It's easier than E=mc2
It's elemental
It's light years ahead
It's a wise choice
It's Radically Simple
It's ...
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Poland

Brazil
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More Screenshot Showcase

Posted by agmg, March 3, 2013, running KDE.

Posted by Droopy, March 16, 2013, running KDE.

Posted by Palko, March 24, 2013, running KDE.

Posted by RobNJ, March 20, 2013, running LXDE.

PCLinuxOS Magazine

Page 56

PCLinuxOS Magazine

Page 57

